CONTENTS

The College of Arts and Social Sciences  3
Why study at ANU?  4
Why Arts and Social Sciences?  5
Types of Programs  7
How to Apply  8
List of Programs  9
Anthropology  13
Arab and Islamic Studies  17
Archaeology  19
Art History and Curatorship  21
Biographical Research and Writing  22
Biological Anthropology  23
Classics  24
Demography and Social Research  28
Drama  30
English  30
Film Studies  30
Forensic Anthropology  30
Gender, Sexuality and Culture  31
Higher Education  31
History  32
Indigenous Australian Studies  33
Interdisciplinary and Cross-Cultural Studies  34
Languages  34
Liberal Arts  34
Cultural and Environmental Heritage  35
Museums and Collections  35
Visual Culture Research  36
Writing, World Histories and Lives  37
Museum Education and Heritage Interpretation  38
Linguistics and Applied Linguistics  38
Music  43
Philosophy  45
Political Science and International Relations  45
Sociology  46
Visual Arts, Design Arts and Digital Arts  46
Who can I talk to? (events and contact details)  49
Postgraduate Glossary  50

Disclaimer: All efforts have been made to ensure the accuracy of the information enclosed in the 2012 ANU College of Arts & Social Sciences Graduate Guide. The College reserves the right to change the details contained in this publication at any point. For the latest information, please visit http://cass.anu.edu.au
ANU College of Arts & Social Sciences

Australian Demographic and Social Research Institute

- Australian Social Science Data Archive

Research School of Humanities and the Arts

- School of Archaeology and Anthropology
- School of Art
- School of Cultural Inquiry
- School of Language Studies
- School of Music
- Australian National Dictionary Centre
- Centre for European Studies
- Digital Humanities Hub
- Freilich Foundation
- Humanities Research Centre
- Institute for Professional Practice in Heritage and the Arts

Research School of Social Sciences

- School of History
- School of Philosophy
- School of Politics and International Relations
- School of Sociology
- Australian Centre of Biography
- Australian National Centre for Latin American Studies
- Australian National Internships Program
- Centre for Aboriginal Economic Policy Research
- Centre for Applied Philosophy and Public Ethics
- Centre for Arab and Islamic Studies (The Middle East and Central Asia)
- Centre for Educational Development and Academic Methods
- Centre for Gambling Research
- Centre for Policy Innovation
- National Institute for Rural and Regional Australia
- Australian National Institute for Public Policy

Naomi Somerville The space in between my kisses and her neck 2010
Cast glass. Photographer: Greg Piper
The College of Arts and Social Sciences at the Australian National University (ANU) is distinctive in its depth, breadth, and disciplinary diversity. At a time when universities are creating generalist programs, our College experience is unique in its ability to draw together more than 20 teaching and research disciplines in the very broad fields of creative arts, humanities and social sciences.

The College has a substantial international research presence, and is a major source of national policy advice. The College builds on the research strengths of the Research School of Humanities and the Arts, the Research School of Social Sciences and the Australian Demographic and Social Research Institute, as well as their Schools and Centres. This enhances the multidisciplinary nature of the College’s research, and provides a research-intensive teaching environment that challenges and inspires the best students.

This is reflected in 2010-11 university rankings by discipline in which the Arts, Humanities and Social Sciences at the ANU are ranked number one in Australia by the Times Higher Education Supplement.

Our staff and graduate cohort come from more than 50 nations and internationalism is a key feature of the College. Extending our internationalism is a priority for the College. Every higher degree research student is offered, on a competitive basis, an overseas component of their education at one of our International Alliance of Research Universities (IARU) partners.

The ANU College of Arts and Social Sciences offers:

- academic staff with international research reputations, including 39 members of one, or both, of the Australian Academy of the Humanities and the Academy of the Social Sciences of Australia, and three Fellows of the British Academy and four ARC Federation Fellows
- exceptional support, including PhD supervisory panels of at least three staff, dedicated office accommodation, library and computing facilities, and some opportunities for sessional work
- generous funds for fieldwork and conference travel, opportunities to apply for scholarships, as well as international semesters of study at our prestigious IARU partner institutions
- access to more than two million volumes in the ANU Library and the vast holdings of the National Library of Australia
- access to a wealth of electronic and traditional research resources
- a vibrant graduate community: there are more than 300 graduate coursework and 450 doctoral students in the College. Each graduate field of study has a cohort of academics that meet regularly to induct students, provide graduate training in their specific fields, conduct staff and student seminars and master classes, and provide opportunities for collaborative work on grants and other projects
- support for students throughout their studies through the Postgraduate and Research Students’ Association (PARSA).

We are committed to creating the best possible research culture for graduates and look forward to welcoming you to our vibrant and exciting intellectual community.

Professor Toni Makkai
Dean and Director
ANU College of Arts & Social Sciences
The Australian National University (ANU) is one of the world’s leading centres of research and learning and is consistently recognised as one of Australia’s top universities. Reaching out to all of Australia and the rest of the world, ANU engages with issues of national and international significance.

The ANU offers students the chance to study alongside and learn from distinguished academics – individuals who contribute at a global level in leading and shaping debate, making vital discoveries and extending knowledge in new and profound directions.

An education at ANU is one that shapes and influences each student. It is informed by the latest research and built on the belief that students should be constantly challenged to discover new skills and ways of thinking. ANU students enjoy small class sizes and continual access to high-quality educators in this interactive, inquiry-based environment.

Positioned close to other Australian national institutions, research organisations, offices of government, foreign missions and the Australian Parliament, ANU has strong relationships with important decision makers – connections which students are able to explore to their full potential.

With links to other internationally renowned universities and industry, students also have multiple opportunities to apply their knowledge to real world situations – both locally and abroad.

ANU students don’t just study and work hard. They enjoy the lifestyle afforded by a campus which sits on 145ha of beautifully maintained parkland located in the heart of Canberra. Students can lead an active, enjoyable and exciting lifestyle through a range of cultural, social, outdoor and sporting societies and clubs.

The landscaped campus contains all the conveniences of a small town including accommodation, medical services, shops, cafés, restaurants, art galleries, sporting fields and a bookshop, as well as exceptional learning and academic centres and facilities.

The ANU campus is an easy walk to central Canberra – a modern and vibrant city which, as the nation’s capital, is home to many iconic cultural, political, recreational and sporting landmarks. For all of these reasons ANU provides a memorable, rewarding and enriching experience for each and every student.
SKILLS AND CAREERS

Postgraduate study allows students to extend their knowledge in a particular field, conduct research, or change career paths. For many students postgraduate study is about further exploring an area of interest and developing advanced and specialised skills. Some of the skills students will gain include:

- Ability to research at a highly analytical level
- Ability to show independent thought and demonstrate initiative
- Critical and creative thinking
- Problem-solving skills
- Communication and presentation skills
- Time management and project management skills

Postgraduate study – including research or coursework – is an investment in a student’s career and future. Career opportunities with a postgraduate degree from ANU's College of Arts and Social Sciences are endless. Careers of previous graduates include:

- Academia and teaching
- Advocacy
- Aid work
- Art production
- Communications
- Community development
- Community management
- Curatorship
- Defence
- Design
- Development
- Diplomacy
- International affairs
- Music performance
- Management
- Media
- Policy
- Project management
- Public service
- Social services

INTERNSHIPS

Some graduate programs offered by the College give students the opportunity to participate in internships as part of their program.

Master of Applied Anthropology and Participatory Development (MAAPD) Internship

Anthropology graduate coursework students have the opportunity to undertake an internship as part of their program. Past MAAPD students have interned at: Environment Australia; Amnesty International; ATSIC branches; SPREP (a regional Pacific organisation); Australian Reproductive Health Alliance; ACFID; and AusAID. The internship is organised by negotiation with the convenor, who will assist and act as mediator as required with potential interning organisations. The internship is an opportunity for students to work in a professional environment, on a project or problem of mutual interest to the student and interning organisation.

For more information please visit: http://studyat.anu.edu.au/courses/ANTH8016;details.html

Master of Archaeological Science Internship

Students in the Master of Archaeological Science are actively encouraged to undertake internships in Commonwealth, State and Local Government Departments; Archaeological Heritage Consulting Companies; Mining, Resource, Infrastructure and Building Industry partners and other University departments.

For more information please visit: http://archaeology.anu.edu.au/archaeologicalscience/internships

Art History Internship

The Art History and Curatorship program offers internships in a range of institutions in Canberra. The Art History Internship is valued at 6 units.

For more information please visit: http://studyat.anu.edu.au/courses/ARTH6998;details.html

Museums and Collections Internship

The Museums and Collections Internship provides students in the Master of Liberal Arts (Museums and Collections) with practical experience in the cultural and collecting, heritage or public history sectors. This also allows students to work with professionals in the field of visual and material culture production and research. Students undertake a workplace-based placement with an agreed cultural and collecting institution, heritage agency, independent professional academic or consultant, or equivalent. Students will generally be given opportunities to experience the variety of an agency’s professional role in curatorial, conservation, registration, public program, front of house and exhibitions, or other roles as appropriate to the placement.

For more information please visit: http://studyat.anu.edu.au/courses/MUSC8004;details.html
ANU Student Mobility Program

Graduate research students may be eligible to study and or conduct research overseas as part of the ANU's Student Mobility Program. For specific eligibility requirements and applications please visit: http://info.anu.edu.au/studyat/International_Office/exchange/outgoingcriteria

Financial Help

From 1 January 2012, all domestic students enrolled in Masters by coursework programs will be eligible to apply for Youth Allowance, Abstudy, or Austudy. For more information on government funded financial assistance please visit: http://www.centrelink.gov.au/internet/internet.nsf/individuals/st_index.htm

Scholarships

Many of the College's Schools and Centres have scholarships available for PhD students. For more information please see: http://cass.anu.edu.au/schools-and-centres

Scholarships are also available for some graduate coursework programs. Please visit http://www.anu.edu.au/sas/scholarships/postgraduatecoursework.php

Dennis Griffen National Composition Master Scholarship:
A one-off full fee-waiver scholarship for a domestic student enrolling in a Master of Music in Composition.

School of Art Travelling Scholarship in Ceramics:
$500 one-off payment to assist a student who is enrolled in an undergraduate or graduate program in Ceramics, who has demonstrated a high capacity for achievement in his or her chosen field of Ceramics. For more information please contact the School of Art.

School of Art Graduate Materials Award:
Stipend of $1000 per annum (tax free) awarded annually to assist all new and continuing students enrolled in a graduate program at the School of Art. The award provides funding for materials and processes to enable students to pursue a proposed program of study. For more information please contact the School of Art.

National Orchestral Scholarship:
Up to $6000 per year for a student who demonstrates outstanding musical ability and accomplishment. The student must be undertaking a Bachelor of Music or a postgraduate program at the ANU School of Music. For more information please contact the School of Music.
The ANU College of Arts and Social Sciences provides both graduate research and graduate coursework degree programs. Admission to a research degree normally requires an Honours degree (at Honours 2A or above) or equivalent prior studies including some research work. Equivalent studies may include a Master degree with graduate research work (to a sufficient standard). Candidates with other qualifications and experience that includes research may be considered for admission.

Admission into a graduate coursework degree can vary according to each program depending on a student’s previous study and professional background. Typically, students will need a four year Bachelor qualification (ie Honours). Graduate Certificate and Graduate Diploma programs are available for students who do not meet these admission requirements (ie students with a three year Bachelor qualification and/or relevant professional work experience).

**GRADUATE RESEARCH**

The College offers two types of graduate research programs: the Doctor of Philosophy (PhD) and the Master of Philosophy (MPhil). From 2011, the College will also offer a research skills training component to each PhD and MPhil program.

**Doctor of Philosophy (PhD)**

Full-time Doctor of Philosophy (PhD) students normally spend a minimum of three years at the ANU, while part-time students spend up to six years. Students based externally normally attend the ANU for a minimum period, equivalent to at least four weeks in each year of enrolment.

For the degree of PhD, candidates are normally required to submit a thesis or creative arts equivalent. The thesis must make a substantial contribution to learning and demonstrate a capacity to relate the research done by the candidate to the broader framework of the discipline (or disciplines) within which it falls. All theses must meet the standard internationally recognised for the degree in the relevant discipline.

**Master of Philosophy (MPhil)**

Degrees of Master of Philosophy (MPhil) are designed for students who require an advanced research qualification, but who want a shorter degree program than the PhD.

The MPhil program is offered on a full-time and part-time basis. It usually takes students between 1.5 and two years full-time, or between three and four years part-time, to complete.

**GRADUATE COURSEWORK**

The College offers four types of graduate coursework programs: Graduate Certificate, Graduate Diploma, Master Degree and Master Degree (Research).

**Graduate Certificate**

Graduate Certificates provide students with the opportunity to obtain new skills and knowledge typically in a discipline in which they have not previously studied but may have relevant work experience, through a short program of study. Typically a Graduate Certificate takes students one semester (full-time or equivalent) to complete and provides a pathway for students into a Graduate Diploma and/or Master degree.

**Graduate Diploma**

A Graduate Diploma allows students to undertake a short graduate study program, typically two semesters full-time or equivalent that builds upon their undergraduate and/or Honours study. Programs are offered across a number of the disciplines in the College, and may provide entry into relevant Master level programs.

**Master Degree**

Master degree programs in the College build on students’ knowledge developed through study in their undergraduate, Honours or Graduate Certificate programs. The Master programs, which often range from two to four semesters of full-time (or equivalent) study, allow students to acquire advanced knowledge and skills in specific areas of the Arts, Humanities, and Social Sciences.

**Master Degree (Research)**

The Master degree (Research) program is available in many Master degree programs in the College to provide students with the opportunity to extend their research skills, and may provide a pathway for students into higher research degrees. The research component adds one semester of full-time study to a student’s program.

Full program information on all ANU College of Arts and Social Sciences graduate research programs is available at: [http://cass.anu.edu.au/future-students/higher-degree-research](http://cass.anu.edu.au/future-students/higher-degree-research)

Full program information on all ANU College of Arts and Social Sciences graduate coursework programs is available at: [http://cass.anu.edu.au/future-students/graduate](http://cass.anu.edu.au/future-students/graduate)
HOW TO APPLY

Admission requirements and deadlines vary depending on the program for which a student is applying and their individual status. There are also different admission requirements for domestic students (citizens and permanent residents of Australia and New Zealand) and international students. English language requirements apply for admission to ANU.

Online applications to the ANU

Students must apply directly to the ANU Admissions Office for these programs with online admission (see pp. 9–11).
T +61 2 6125 5594
E admis.enq@anu.edu.au
W www.anu.edu.au/sas/admission

Applications through the University Admissions Centre (UAC)

For domestic students, it is necessary to apply for most of the graduate coursework programs through the University Admissions Centre (UAC). Details and application procedures are available through UAC:
T +61 2 9752 0200
W www.uac.edu.au/postgraduate

Key Dates

21 February 2011 Semester 1 starts
15 April 2011 International applications close for Semester 2, 2011
31 May 2011 Australian applications close for Semester 2, 2011
25 July 2011 Semester 2 starts
31 August 2011 Research scholarship applications close for international students for Semester 1, 2012
28 October 2011 Research scholarship applications close for domestic students for Semester 1, 2012
15 November 2011 International applications close for Semester 1, 2012
30 November 2011 Australian applications close for Semester 1, 2012
20 February 2012 Semester 1, 2012 starts
23 July 2012 Semester 2, 2012 starts
## List of Programs

<table>
<thead>
<tr>
<th>Program</th>
<th>CRICOS</th>
<th>UAC</th>
<th>Online</th>
<th>Domestic</th>
<th>International</th>
<th>F/T Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graduate Certificate in Anthropology</td>
<td>072348J</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td>0.5 years</td>
</tr>
<tr>
<td>Graduate Certificate in Archaeological Practice</td>
<td>072343C</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td>0.5 years</td>
</tr>
<tr>
<td>Graduate Certificate in Archaeological Science</td>
<td>072342D</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td>0.5 years</td>
</tr>
<tr>
<td>Graduate Certificate in Archaeological Studies</td>
<td>072344B</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td>0.5 years</td>
</tr>
<tr>
<td>Graduate Certificate in Biological Anthropology</td>
<td>072339K</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td>0.5 years</td>
</tr>
<tr>
<td>Graduate Certificate in Development</td>
<td>072353A</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td>0.5 years</td>
</tr>
<tr>
<td>Graduate Certificate in Digital Arts</td>
<td>072338M</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td>0.5 years</td>
</tr>
<tr>
<td>Graduate Certificate in Higher Education</td>
<td>-</td>
<td>X</td>
<td></td>
<td>not available</td>
<td></td>
<td>1 year (P/T only)</td>
</tr>
<tr>
<td>Graduate Certificate in Indigenous Policy &amp; Development</td>
<td>-</td>
<td>X</td>
<td></td>
<td>not available</td>
<td></td>
<td>1 year (P/T only)</td>
</tr>
<tr>
<td>Graduate Certificate in Liberal Arts (Cultural and Environmental Heritage)</td>
<td>064768M</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td>0.5 years</td>
</tr>
<tr>
<td>Graduate Certificate in Liberal Arts (Museums and Collections)</td>
<td>064769M</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td>0.5 years</td>
</tr>
<tr>
<td>Graduate Certificate in Liberal Arts (Visual Culture Research)</td>
<td>064769M</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td>0.5 years</td>
</tr>
<tr>
<td>Graduate Certificate in Liberal Arts (Writing, World Histories and Lives)</td>
<td>064769M</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td>0.5 years</td>
</tr>
<tr>
<td>Graduate Certificate in Linguistics</td>
<td>072331G</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td>0.5 years</td>
</tr>
<tr>
<td>Graduate Certificate in Middle Eastern and Central Asian Studies</td>
<td>074013E</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td>0.5 years</td>
</tr>
<tr>
<td>Graduate Certificate in Museum Education and Heritage Interpretation</td>
<td>071785F</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td>0.5 years</td>
</tr>
<tr>
<td>Graduate Certificate in Music Performance</td>
<td>030732D</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td>0.5 years</td>
</tr>
<tr>
<td>Graduate Certificate in Social Research</td>
<td>061880B</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td>0.5 years</td>
</tr>
<tr>
<td>Graduate Certificate in Visual Arts</td>
<td>072335C</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td>0.5 years</td>
</tr>
<tr>
<td>Graduate Diploma in Arts (Art History)</td>
<td>012053K</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td>1 year</td>
</tr>
<tr>
<td>Graduate Diploma in Arts (Art History and Curatorship)</td>
<td>012053K</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td>1 year</td>
</tr>
<tr>
<td>Graduate Diploma in Arts (Classics)</td>
<td>012053K</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td>1 year</td>
</tr>
<tr>
<td>Graduate Diploma in Arts (History)</td>
<td>012053K</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td>1 year</td>
</tr>
<tr>
<td>Graduate Diploma in Digital Arts</td>
<td>072539B</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td>1 year</td>
</tr>
<tr>
<td>Graduate Diploma in Music</td>
<td>012074E</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td>1 year</td>
</tr>
<tr>
<td>Graduate Diploma in Visual Arts</td>
<td>012070J</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td>1 year</td>
</tr>
<tr>
<td>PROGRAM</td>
<td>CRICOS</td>
<td>APPLICATION METHOD</td>
<td>F/T DURATION</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>----------</td>
<td>--------------------</td>
<td>--------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Domestic</td>
<td>International</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>UAC</td>
<td>Online</td>
<td>Online</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Anthropology</td>
<td>050087G</td>
<td>X</td>
<td>X</td>
<td>1 year</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Applied Anthropology &amp; Participatory Development</td>
<td>036808G</td>
<td>X</td>
<td>X</td>
<td>1 year</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Applied Linguistics</td>
<td>065806G</td>
<td>X</td>
<td>X</td>
<td>1 year</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Archaeological Science</td>
<td>061834G</td>
<td>X</td>
<td>X</td>
<td>1 year</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Archaeological Studies</td>
<td>072345A</td>
<td>X</td>
<td>X</td>
<td>1 year</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Biographical Research &amp; Writing</td>
<td>073525M</td>
<td>X</td>
<td>X</td>
<td>1 year</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Biological Anthropology</td>
<td>072340F</td>
<td>X</td>
<td>X</td>
<td>1 year</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Culture, Health &amp; Medicine</td>
<td>063257J</td>
<td>X</td>
<td>X</td>
<td>1 year</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Design Arts</td>
<td>055645G</td>
<td>X</td>
<td>X</td>
<td>1 year</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Digital Arts</td>
<td>072541G</td>
<td>X</td>
<td>X</td>
<td>1 year</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Diplomacy/Master of Middle Eastern &amp; Central Asian Studies</td>
<td>048403B</td>
<td>X</td>
<td>X</td>
<td>1.5 years</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Higher Education</td>
<td>-</td>
<td>X</td>
<td>not available</td>
<td>2 years (P/T only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Islam in the Modern World</td>
<td>065139K</td>
<td>X</td>
<td>X</td>
<td>1 year</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Liberal Arts (Cultural &amp; Environmental Heritage)</td>
<td>064770F</td>
<td>X</td>
<td>X</td>
<td>1 year</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Liberal Arts (Museums &amp; Collections)</td>
<td>064770F</td>
<td>X</td>
<td>X</td>
<td>1 year</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Liberal Arts (Visual Culture Research)</td>
<td>064770F</td>
<td>X</td>
<td>X</td>
<td>1 year</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Liberal Arts (Writing, World Histories and Lives)</td>
<td>064770F</td>
<td>X</td>
<td>X</td>
<td>1 year</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Linguistics</td>
<td>043521G</td>
<td>X</td>
<td>X</td>
<td>1 year</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Middle Eastern &amp; Central Asian Studies</td>
<td>049043G</td>
<td>X</td>
<td>X</td>
<td>1 year</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Music</td>
<td>030736M</td>
<td>X</td>
<td>X</td>
<td>1 year</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Social Research</td>
<td>061772F</td>
<td>X</td>
<td>X</td>
<td>1 year</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Translation</td>
<td>070157K</td>
<td>X</td>
<td>X</td>
<td>1 year</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Visual Arts</td>
<td>012071G</td>
<td>X</td>
<td>X</td>
<td>1 year</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PROGRAM</td>
<td>CRICOS</td>
<td>APPLICATION METHOD</td>
<td>F/T DURATION</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------------------------------------------------</td>
<td>--------</td>
<td>--------------------</td>
<td>--------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Anthropology (Research)</td>
<td>072352B</td>
<td>X</td>
<td>X</td>
<td>1.5 years</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Applied Anthropology &amp; Participatory Development (Research)</td>
<td>070864E</td>
<td>X</td>
<td>X</td>
<td>1.5 years</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Applied Linguistics (Research)</td>
<td>072334D</td>
<td>X</td>
<td>X</td>
<td>1.5 years</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Archaeological Science (Research)</td>
<td>072347K</td>
<td>X</td>
<td>X</td>
<td>1.5 years</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Archaeological Studies (Research)</td>
<td>072346M</td>
<td>X</td>
<td>X</td>
<td>1.5 years</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Arts (Art History)</td>
<td>012067D</td>
<td>X</td>
<td>X</td>
<td>2 years</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Arts (Art History &amp; Curatorship)</td>
<td>012067D</td>
<td>X</td>
<td>X</td>
<td>2 years</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Arts (Classics)</td>
<td>012067D</td>
<td>X</td>
<td>X</td>
<td>2 years</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Arts (History)</td>
<td>012067D</td>
<td>X</td>
<td>X</td>
<td>2 years</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Arts (Indigenous Australian Studies)</td>
<td>012067D</td>
<td>X</td>
<td>X</td>
<td>2 years</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Biological Anthropology (Research)</td>
<td>072341E</td>
<td>X</td>
<td>X</td>
<td>1.5 years</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Culture, Health &amp; Medicine (Research)</td>
<td>074015C</td>
<td>X</td>
<td>X</td>
<td>1.5 years</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Digital Arts (Research)</td>
<td>072542G</td>
<td>X</td>
<td>X</td>
<td>1.5 years</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Liberal Arts (Cultural &amp; Environmental Heritage) - (Research)</td>
<td>073476D</td>
<td>X</td>
<td>X</td>
<td>1.5 years</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Liberal Arts (Museums &amp; Collections) - (Research)</td>
<td>0734788B</td>
<td>X</td>
<td>X</td>
<td>1.5 years</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Liberal Arts (Visual Culture Research) - (Research)</td>
<td>0073475E</td>
<td>X</td>
<td>X</td>
<td>1.5 years</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Liberal Arts (Writing, World Histories &amp; Lives) - (Research)</td>
<td>0734477C</td>
<td>X</td>
<td>X</td>
<td>1.5 years</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Linguistics (Research)</td>
<td>072332F</td>
<td>X</td>
<td>X</td>
<td>1.5 years</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master of Visual Arts (Research)</td>
<td>072337A</td>
<td>X</td>
<td>X</td>
<td>1.5 years</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PROGRAM</th>
<th>CRICOS</th>
<th>APPLICATION METHOD</th>
<th>F/T DURATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Doctor of Philosophy (PhD) (ADSRI)</td>
<td>063447C</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Doctor of Philosophy (PhD) (RSHA)</td>
<td>048381G</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Doctor of Philosophy (PhD) (RSSS)</td>
<td>036805K</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Master of Philosophy (MPhil) (ADSRI)</td>
<td>063447C</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Master of Philosophy (MPhil) (RSHA)</td>
<td>048381G</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Master of Philosophy (MPhil) (RSSS)</td>
<td>048407C</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
PHILIP FOUNTAIN

PhD in Anthropology

Specialisation: International aid and development

I chose the ANU because of its outstanding academic reputation and the quality of its staff. Importantly, I was able to identify a research supervisor who was enthusiastic about my research interests. I also viewed Canberra as a very liveable city for me and my family to relocate to.

The most exciting parts of my PhD research have been the seminars, conferences and opportunities to interact with other ANU students and staff. I was also fortunate to undertake ethnographic fieldwork in Indonesia, the United States, and Canada.

My advice to students considering undertaking research at the ANU is to visit the campus and get to know some prospective supervisors. Keep an open mind about your research interests – although I initially planned to research in the area of Cultural Geography, as had been the focus of my undergraduate studies, I now appreciate having found a supervisor who has also encouraged me to explore the breadth, depth and quality of Anthropological work.
ANTHROPOLOGY

Programs offered
Doctor of Philosophy (PhD)
Master of Philosophy (MPhil)
Master of Anthropology (Research)
Master of Anthropology
Master of Applied Anthropology and Participatory Development (Research)
Master of Applied Anthropology and Participatory Development
Master of Culture, Health and Medicine (Research)
Master of Culture, Health and Medicine
Graduate Certificate in Anthropology
Graduate Certificate in Development
Graduate Certificate in Indigenous Policy and Development

Anthropology involves the study of cultural differences and similarities in a globalised world. ANU is a leading international centre for Anthropological teaching and research with students and staff from all over the world. The range of Anthropology teaching and research at ANU currently focuses on: Australia (Indigenous, settler, and migrant communities), Melanesia, Indonesia, China, Korea, Laos, Malaysia, Thailand, Vietnam, Germany, Polynesia, and India.

The University’s theoretical and analytical interests include: development; markets and exchange systems; colonialism, globalisation and the transformation of traditional societies; symbolic and artistic systems; and visual anthropology. The College also focuses on: the anthropology of gender; popular culture; nationalism, post-colonialism and post-socialism; human health and ecology; kinship and social organisation; biosocial anthropology, and primatology. Other topics include: medical, nutritional and demographic anthropology; language and culture; religion and ritual; anthropology of emotion; urban societies; the history of anthropology; and rural change in Europe.

Fieldwork is an important component of study at PhD level and students are encouraged to conduct intensive fieldwork, for which they normally receive financial support.

For further information on graduate research programs in Anthropology contact:
Graduate Convenor
E: anthropology.gradprog@anu.edu.au
W: http://archanth.anu.edu.au/

MASTER OF ANTHROPOLOGY

Master of Anthropology (Research)
Graduate Certificate in Anthropology

Graduate studies in Anthropology at the ANU focuses on studies of Anthropology in Australia, the Pacific, and Asia.

The breadth of the graduate courses is large, with courses covering cultural, biological, and forensic anthropology.

The programs are suitable for those who seek academic preparation for a career in a professional area requiring a solid understanding of Anthropology, such as in cultural institutions and the public service.

Typical courses
> Advanced Issues in Anthropology
> Critically Assessing Contemporary Development Practice
> Forms of Sociality
> Introduction to Australian Indigenous Policy
> Introduction to Gender and Development
> Law, Order and Conflict in the Pacific
> Medical Anthropology
> Migration, Refugees and Development
> Photography in Social Context
> Practical Studies in Social Analysis
> Social Animals: Anthropological Perspectives on Animal-human relationships
> Topics in the History of Anthropology

ENTRY
Graduate Certificate in Anthropology
Applicants should have a three year Bachelors degree from an Australian tertiary institution or its international equivalent. Applicants without a first degree, but with relevant professional experience and appropriate prior learning, will be eligible for admission into the Graduate Certificate in Anthropology.

Master of Anthropology
Applicants should have a four year Bachelors degree either as Honours or a combined degree in a cognate area from an Australian tertiary institution or its international equivalent. Equivalence may be met by the completion of the Graduate Certificate in Anthropology.

Master of Anthropology (Research)
Applicants must have completed the Master of Anthropology with a minimum 70% course average.

ATTENDANCE
On campus

DURATION
Graduate Certificate in Anthropology
0.5 years full-time (courses to the value of 24 units)

Master of Anthropology
1 year full-time (courses to the value of 48 units)

Master of Anthropology (Research)
1.5 years full-time (courses to the value of 72 units)

FULL PROGRAM INFORMATION
http://info.anu.edu.au/studyat/

FURTHER INFORMATION
admin.arch&anth@anu.edu.au
MASTER OF APPLIED ANTHROPOLOGY
& PARTICIPATORY DEVELOPMENT

Master Of Applied Anthropology & Participatory Development (Research)

The Master of Applied Anthropology and Participatory Development (MAAPD) is designed for students with an interest in the application of Anthropology’s critical methods and styles to social issues in development. The MAAPD program provides students with an understanding of the principal ways in which critical social inquiry and participatory processes can be applied to the design, implementation, monitoring, and evaluation of development activities. The program and its specialisations are designed for people working in government, non-government organisations, or as independent consultants.

The MAAPD is available in the following four specialisations: Gender and Development; Indigenous Policy; Conflict and Development; and Society and Environment. As part of the program, students also have the opportunity to undertake an internship (see page 5 for more information).

Typical courses

> Introduction to Australian Indigenous Development
> Introduction to Australian Indigenous Policy
> Introduction to Gender and Development
> Issues in the Design and Evaluation of Development Projects and Programs
> Key Concepts in Anthropology of Development
> Law, Order and Conflict in the Pacific
> MAAPD Internship
> Migration, Refugees and Development
> Participatory Modeling for Development
> Resource Projects and Indigenous Peoples
> Social Impact Studies in Project Cycle
> Social Mapping and Community Politics

ENTRY

Master of Applied Anthropology and Participatory Development

Applicants should have a four year Bachelors degree either as Honours or a combined degree in a cognate area from an Australian tertiary institution or its international equivalent. Equivalence may be met by the completion of the Graduate Certificate in Development or Graduate Certificate in Indigenous Policy & Development. Relevant work experience of at least one year in a developing country, or two years in Australia working in the field of development or a related area, will be regarded as recognised prior learning to gain admission.

Master of Applied Anthropology and Participatory Development (Research)

Applicants must have completed the Master of Applied Anthropology and Participatory Development with a minimum 70% course average.

ATTENDANCE

This program is available online and on campus.

DURATION

Master of Applied Anthropology and Participatory Development
1 year full-time (courses to the value of 48 units)

Master of Applied Anthropology and Participatory Development (Research)
1.5 years full-time (courses to the value of 72 units)

FULL PROGRAM INFORMATION

http://info.anu.edu.au/studyat/

FURTHER INFORMATION

maapd@anu.edu.au

MASTER OF CULTURE, HEALTH & MEDICINE

Master of Culture, Health & Medicine (Research)

The Master of Culture, Health and Medicine (MCHAM) is an interdisciplinary initiative between the College of Arts and Social Sciences and the College of Medicine, Biology, and Environment, focusing on Medical Anthropology and Health Sciences.

The MCHAM is composed of a general stream, and five specialisations of: Global Health and Development; Health Policy and Ethics; Health and Gender; Health and Environment; and Health and Indigenous Australia.

Particular emphasis is placed on the problems of combining anthropological perspectives and medical practices with other forms of technical expertise in health-related research and practice.

Typical courses

> Ancient Health and Disease
> Ancient Medicine
> Critically Assessing Contemporary Development Practice
> Cultural Epidemiology: Theory and Methods
> Directed Readings in Culture, Health and Medicine
> Global Health and Development
> Health and Disease in a Changing World
> Health and Inequality in Latin America
> Indigenous Australian Societies and Culture
> Introduction to Australian Indigenous Policy
> Introduction to Gender and Development
> Key Concepts in Anthropology of Development
> Nutrition, Disease and the Human Environment
> Perspectives on Culture, Health and Medicine
> Qualitative Methodologies for Health Research
> Representing Medicine: Performance, Drama and Identity
> Research Project in Culture, Health and Medicine
ENTRY
Master of Culture, Health & Medicine
Applicants should have a four year Bachelors degree either as Honours or a combined degree in a cognate area from an Australian tertiary institution or its international equivalent. Equivalence may be met by the completion of the Graduate Certificate in Anthropology.

Master of Culture, Health & Medicine (Research)
Applicants must have completed the Master of Culture, Health & Medicine with a minimum 70% course average.

ATTENDANCE
On campus

DURATION
1 year full-time (courses to the value of 48 units)

FULL PROGRAM INFORMATION
http://info.anu.edu.au/studyat/

FURTHER INFORMATION
E mcham.convener@anu.edu.au
W http://cass.anu.edu.au/future-students/graduate/mcham

GRADUATE CERTIFICATE IN DEVELOPMENT
The Graduate Certificate in Development provides students with an introduction to Development Studies and the key principles and theories that underpin much development practice. Development Studies courses at the ANU include: participatory development, development economics, environment and development, public policy, gender, and conflict and development.

The Certificate is an entry-level graduate program for students who have not previously completed studies in the field of Development. Students wishing to study at Master level may articulate into the Master of Applied Anthropology and Participatory Development (MAAPD) on successful completion of the Certificate.

ENTRY
Applicants should have a three year Bachelors degree from an Australian tertiary institution or its international equivalent. Applicants without a first degree, who have relevant work experience of at least one year in a developing country, or two years in Australia working in the field of development or a related area, will be regarded as recognised prior learning to gain admission.

ATTENDANCE
On campus

DURATION
2 semesters - available part-time and to domestic students only (courses to the value of 24 units)

FULL PROGRAM INFORMATION
http://info.anu.edu.au/studyat/

FURTHER INFORMATION
http://caepr.anu.edu.au/contact

GRADUATE CERTIFICATE IN INDIGENOUS POLICY & DEVELOPMENT
The Graduate Certificate in Indigenous Policy and Development provides students with an understanding and interpretation of the evolution and practice of Australian Indigenous affairs policies. It also gives students an appreciation and analysis of development activities within Australian Indigenous communities. Particular emphasis is placed on the problems of combining Indigenous perspectives with other forms of technical expertise in policy and development work. On completion of the Certificate, graduates will be better able to understand and contribute to Indigenous policy and development.

The Certificate provides an opportunity to be trained by, and engage with, staff from the Centre for Aboriginal Economic Policy Research (CAEPR) - Australia’s leading research centre on Indigenous economic and social policy issues.

ENTRY
Applicants should have a three year Bachelors degree from an Australian tertiary institution or its international equivalent. Applicants without a first degree, who have relevant work experience of at least one year in a developing country, or two years in Australia working in the field of development or a related area, will be regarded as recognised prior learning to gain admission.

ATTENDANCE
On campus

DURATION
2 semesters - available part-time and to domestic students only (courses to the value of 24 units)

FULL PROGRAM INFORMATION
http://info.anu.edu.au/studyat/

FURTHER INFORMATION
http://caepr.anu.edu.au/contact
ARAB & ISLAMIC STUDIES

Programs offered
- Doctor of Philosophy (PhD)
- Master of Philosophy (MPhil)
- Master of Arts (Middle Eastern and Central Asian Studies)
- Master of Middle Eastern and Central Asian Studies
- Master of Islam in the Modern World
- Master of Diplomacy/Master of Middle Eastern and Central Asian Studies
- Graduate Certificate in Middle Eastern and Central Asian Studies

The Centre for Arab and Islamic Studies (The Middle East and Central Asia) is the first of its kind in Australia. It focuses on Iran, Central Asia, and particularly the Arab world.

The Centre integrates the study of Middle Eastern and Central Asian contemporary politics, history, culture, political economy, economics, and the religion of Islam within the broader framework of the changing global order. The Centre fosters the study of the region’s most relevant languages of Arabic, Persian, and Turkish. It also focuses on issues pertinent to Australia’s interests in, and the development of its commercial, scientific and industrial ties with the Middle East and Central Asia.

The PhD and MPhil in the Centre are designed for students who wish to complete a detailed piece of research. Both degrees, which may be taken part-time, suit students who are passionate about a specialised area, or who are seeking specialist careers in academia, multilateral organisations, or consulting firms.

Supervision can be provided for a wide range of topics including: Middle Eastern and Central Asian politics, history, political economy, Persian, Turkish and Arabic languages, literature and culture, and Islamic studies.

For further information on graduate research in the Centre please contact:
The Centre for Arab and Islamic Studies (The Middle East and Central Asia)
E cais@anu.edu.au
W http://cais.anu.edu.au/

MASTER OF ARTS (MIDDLE EASTERN & CENTRAL ASIAN STUDIES)
The Master of Arts specialising in Middle Eastern and Central Asian Studies is designed for students who seek the academic preparation for a career in a professional area requiring a solid understanding of the Middle East and Central Asia. This may include: diplomacy, the public service, teaching, journalism, or business.

Typical courses
- Central Asia in Regional and Global Perspectives
- Dynamics of Israeli-Palestinian Conflict
- Energy and Security
- Islam, the West and International Terrorism
- Islamic Radicalism
- Issues of Development in the Middle East
- Modern Turkey: History, Culture and Regional Relations
- Oil, Religion, Politics and Conflict in the Middle East
- The Gulf Strategic Environment
- Arabic language
- Persian language
- Turkish language

ENTRY
Applicants should have a four year Bachelors degree either as Honours or a combined degree in a cognate area from an Australian tertiary institution or its international equivalent. Equivalence may be met by the completion of the Graduate Certificate in Middle Eastern and Central Asian Studies.

ATTENDANCE
On campus

DURATION
Master of Arts (Middle Eastern and Central Asian Studies)
2 years full-time (courses to the value of 72 units)

STRUCTURE
Part A: Courses to the value of 36 units (6 courses)
Part B: Thesis of 15,000-20,000 words (36 units)

FULL PROGRAM INFORMATION
http://info.anu.edu.au/studyat/

FURTHER INFORMATION
cais@anu.edu.au

MASTER OF ISLAM IN THE MODERN WORLD
The Master of Islam in the Modern World is a unique program in its interdisciplinary approach, global focus, and flexibility. It draws on the strength of the CAIS in its integration of the study of Middle Eastern and Central Asian contemporary politics, history, culture, political economy, economics, and the religion of Islam, within the broader framework of the changing global order.

The CAIS fosters the study of the region’s most relevant languages of Arabic, Persian, and Turkish. The Centre also focuses on issues pertinent to Australia’s interests in, and the development of, its commercial, scientific and industrial ties with its areas of coverage.
Typical courses
>
> Approaches to the Study of Modern Muslim Societies
> Islam and Democracy
> Islam, Faith and Community
> Islam in Australia
> Islam in Central Asia
> Islam in Turkey
> Islam in World Politics
> Islam, the West and International Terrorism
> Shi’ite Islam in World Politics
> Special Topic in Modern Islam
> The Politics of Islam in Southeast Asia

ENTRY
Applicants should have a four year Bachelors degree either as Honours or a combined degree in a cognate area from an Australian tertiary institution or its international equivalent. Equivalence may be met by the completion of the Graduate Certificate in Middle Eastern and central Asian Studies.

ATTENDANCE
On campus

DURATION
1 year full-time (courses to the value of 48 units)

FULL PROGRAM INFORMATION
http://info.anu.edu.au/studyat/

FURTHER INFORMATION
cais@anu.edu.au

MASTER OF MIDDLE EASTERN & CENTRAL ASIAN STUDIES

Master of Diplomacy/Master of Middle Eastern & Central Asian Studies

Graduate Certificate in Middle Eastern & Central Asian Studies

The graduate programs in Middle Eastern and Central Asian Studies are designed for students seeking a professional qualification, with broad study of Middle Eastern and Central Asian politics, international relations, modern history, and political economy. The aim of the program is to prepare those who seek academic preparation for a career in a professional area requiring a solid understanding of the Middle East and Central Asia - whether in diplomacy, the public service, teaching, journalism, or business.

Students may also complete a Master of Diplomacy/Master of Middle Eastern and Central Asian Studies. The Master of Diplomacy can be taken through the Asia Pacific College of Diplomacy and students will graduate with two Master degrees.

The Graduate Diploma is designed for students seeking an introduction to the Middle East and Central Asia at graduate level, or as a pathway to the Master of Arts or Master of Middle Eastern and Central Asian Studies.

Typical courses
>
> Islamic Radicalism
> Central Asia in Regional and Global Perspectives
> Issues of Development in the Middle East
> Energy and Security
> Islam, the West and International Terrorism
> Dynamics of Israeli-Palestinian Conflict
> The Gulf Strategic Environment
> Special Topic in Middle Eastern and Central Asian Studies: Islam in World Politics
> Special Topic in Middle Eastern and Central Asian Studies: Islam and Democracy
> Geopolitics of Central Asia
> Arabic language
> Persian language
> Turkish language

ENTRY
Graduate Certificate in Middle Eastern & Central Asian Studies
Applicants should have a three year Bachelor degree from an Australian tertiary institution or its international equivalent. Applicants without a first degree, but with relevant professional experience and appropriate prior learning, will be eligible for admission into the Graduate Certificate in Middle Eastern & Central Asian Studies.

Master of Middle Eastern & Central Asian Studies & Master of Diplomacy/Master of Middle Eastern & Central Asian Studies
Applicants should have a four year Bachelors degree either as Honours or a combined degree in a cognate area from an Australian tertiary institution or its international equivalent. Equivalence may be met by the completion of the Graduate Certificate in Middle Eastern & Central Asian Studies.

ATTENDANCE
On campus

DURATION
Graduate Certificate in Middle Eastern & Central Asian Studies
0.5 years full-time (courses to the value of 24 units)

Master of Middle Eastern & Central Asian Studies
1 year full-time (courses to the value of 48 units)

Master of Diplomacy/Master of Middle Eastern & Central Asian Studies
2 years full-time (courses to the value of 84 units)

FULL PROGRAM INFORMATION
http://info.anu.edu.au/studyat/

FURTHER INFORMATION
cais@anu.edu.au
ARCHAEOLOGY

Programs offered

Doctor of Philosophy (PhD)
Master of Philosophy (MPhil)
Master of Archaeological Science (Research)
Master of Archaeological Science
Master of Archaeological Studies (Research)
Master of Archaeological Studies
Graduate Certificate in Archaeological Science
Graduate Certificate in Archaeological Studies
Graduate Certificate in Archaeological Practice

Archaeology is the study of past human activities, emphasising interpretations of material evidence. By excavating the physical remains of people, the places they lived, and the objects they made and used, archaeologists gain knowledge of human history and prehistory. Archaeology may be applied to all periods of the human past - from the first evidence of tool-making hominids two and a half million years ago, to the grand civilisations of the ancient world, to the recent history of colonial Australia. The approach of Archaeology gives insights into the lost or hidden behaviour of people and cultures of earlier times.

The ANU is a leading international centre for Archaeological research on a wide range of aspects of world Archaeology and Paleoanthropology. Current research is focused on Australia, the Pacific, Southeast Asia, and South America, while we also have interests in Africa and Europe. The University's research fields include: human evolution; bioarchaeology; Pleistocene and recent hunter-gatherer archaeology; landscape and environmental archaeology; agricultural origins and dispersals; archaeology and linguistics; stone working technology; gender; cultural resource management; taphonomy; and archaeological science.

The ANU also has a strong commitment to fieldwork-based graduate research in Archaeology. Supervisory support is offered over a wide range of theoretical interests including: human evolution; bioarchaeology; hunter-gatherer archaeology; landscape and environmental archaeology; agricultural origins and dispersals; archaeology and linguistics; stone working technology; and archaeological science.

For further information on graduate research programs in Archaeology & Palaeoanthropology contact:

Graduate Convenor
E archpal@anu.edu.au
W http://info.anu.edu.au/studyat/Graduate_School/Study_Fields/archpal

MASTER OF ARCHAEOLOGICAL SCIENCE

Master of Archaeological Science (Research)

Graduate Certificate in Archaeological Science

The Master and Graduate Certificate of Archaeological Science are taught across four ANU Colleges: ANU College of Arts and Social Sciences, ANU College of Asia and Pacific, ANU College of Medicine, Biology and Environment, and the ANU College of Physical and Mathematical Sciences. The programs offer a bridge between the humanities orientation of traditional Archaeology and the modern scientific principles, analytical techniques, and methods to archaeological research questions and field investigations. The Master program is designed to provide systematic training to students from either humanities or science-based backgrounds.

The Master of Archaeological Science offers internships and field trips within the program.

Typical courses

> Advanced Field Training in Archaeological Science
> Analysis of Mammalian Remains
> Applied Geographic Information Science
> Archaeological Research in Australia
> Archaeological Science Research Project
> Archaeological Studies Foundation
> Archaeology of the Pacific Islanders
> Archaeology, Climate Change and Society
> Australian Archaeology
> Climate Change Science
> Contemporary Issues in Archaeology
> Decay and Disturbance: Archaeological Formation Processes
> Designing Research in Archaeology
> Ethics, Issues and Consequences of Science
> Forensic Anthropology and Archaeology
> Genomics and Biotechnology
> Health and Disease in a Changing World
> Human Skeletal Analysis
> Imaging Earth Structure
> Indigenous Collections and Exhibitions
> Introduction to Archaeological Science
> Introduction to Cultural Heritage Management
> Introduction to Environmental Archaeology
> Introduction to Natural Hazards
> Introduction to Remote Sensing and Geographical Information System
> Introduction to Rock Art Research: Community Consultation and Documentation
> Managing, Mapping and Detecting Archaeological Sites
> Palaeo-Environmental Reconstruction
> People at Risk from Hazards in the Asia-Pacific
> Quantitative Analysis in Archaeology
> Science Communications and Creative Teaching
> Scientific Dating and Isotope Analysis for Archaeology and Palaeoanthropology
> Thinking about Hazards and People
> Understanding Geological Hazards
> World Rock Art: Global Perspectives on Rock Art Research

**ENTRY**

**Graduate Certificate in Archaeological Science**
Applicants should have a three year Bachelor's degree from an Australian tertiary institution or its international equivalent. Applicants without a first degree, but with relevant professional experience and appropriate prior learning, will be eligible for admission into the Graduate Certificate in Archaeological Science.

**Master of Archaeological Science**
Applicants should have a four year Bachelor's degree either as Honours or a combined degree in a cognate area from an Australian tertiary institution or its international equivalent. Equivalence may be met by the completion of the Graduate Certificate in Archaeological Science.

**Master of Archaeological Science (Research)**
Applicants must have completed the Master of Archaeological Science with a minimum 70% course average.

**ATTENDANCE**
On campus

**DURATION**
**Graduate Certificate in Archaeological Science**
0.5 years full-time (courses to the value of 24 units)

**Master of Archaeological Science**
1 year full-time (courses to the value of 48 units)

**Master of Archaeological Science (Research)**
1.5 years full-time (courses to the value of 72 units)

**FULL PROGRAM INFORMATION**
http://info.anu.edu.au/studyat/

**FURTHER INFORMATION**
E archaeological.science@anu.edu.au
W http://archaeology.anu.edu.au/archaeologicalscience/archaeological-science-anu

**MASTER OF ARCHAEOLOGICAL STUDIES**

**Master of Archaeological Studies (Research)**
**Graduate Certificate in Archaeological Studies**
The Archaeological Studies graduate programs are for students interested in understanding the human past through archaeological material. The programs approach Archaeology from the perspective of humanities and social sciences, rather than from a scientific perspective, as is the case with the Master of Archaeological Science. The Master program builds on the Graduate Certificate in Archaeological Studies, and is designed to help students broaden, or deepen their knowledge in the field of Archaeology.

**Typical courses**
> Advanced Archaeology
> Ancient Health and Disease
> Ancient Medicine
> Archaeological Field and Laboratory Methods
> Archaeological Research in Australia
> Archaeological Studies Foundation
> Archaeology and the Document
> Archaeology and the Sacred Landscape
> Archaeology of Death and Mortuary Practices
> Archaeology of Mexico and Maya
> Archaeology of the Central Andes
> Archaeology of the Pacific Islanders
> Australian Archaeology
> Forensic Anthropology and Archeology
> Human Evolution
> Human Skeletal Analysis
> Introduction to Archaeological Science
> Introduction to Environmental Archaeology
> Introduction to Heritage Studies
> Landscape Archaeology
> Post-Roman Archaeology of Britain: Arthur and the Anglo Saxons
> Research Design and Analysis in Archaeology
> Scientific Dating and Isotope Analysis for Archaeology and Palaeoanthropology
> Topics in Pacific Archaeology

**ENTRY**

**Graduate Certificate in Archaeological Studies**
Applicants should have a three year Bachelor's degree from an Australian tertiary institution or its international equivalent. Applicants without a first degree, but with relevant professional experience and appropriate prior learning, will be eligible for admission into the Graduate Certificate in Archaeological Studies.

**Master of Archaeological Studies**
Applicants should have a four year Bachelor's degree either as Honours or a combined degree in a cognate area from an Australian tertiary institution or its international equivalent. Equivalence may be met by the completion of the Graduate Certificate in Archaeological Science or the Graduate Certificate in Archaeological Studies.

**Master of Archaeological Studies (Research)**
Applicants must have completed the Master of Archaeological Studies with a minimum 70% course average.

**ATTENDANCE**
On campus
DURATION
Graduate Certificate in Archaeological Studies
0.5 years full-time (courses to the value of 24 units)
Master of Archaeological Studies
1 year full-time (courses to the value of 48 units)
Master of Archaeological Studies (Research)
1.5 years full time (courses to the value of 72 units)

FULL PROGRAM INFORMATION
http://info.anu.edu.au/studyat/
FURTHER INFORMATION
admin.arch&anth@anu.edu.au

Graduate Certificate in Archaeological Practice
The Graduate Certificate in Archaeological Practice provides students with a high level understanding of Archaeological methods and the human past as revealed through Archaeology.

ENTRY
Applicants should have a three year Bachelors degree from an Australian tertiary institution or its international equivalent. Applicants without a first degree, but with relevant professional experience and appropriate prior learning, will be eligible for admission into the Graduate Certificate in Archaeological Practice.

ATTENDANCE
On campus

DURATION
0.5 years full-time (courses to the value of 24 units)

FURTHER INFORMATION
admin.arch&anth@anu.edu.au

ART HISTORY & CURATORSHIP
Programs offered
Doctor of Philosophy (PhD)
Master of Philosophy (MPhil)
Master of Arts (Art History)
Master of Arts (Art History and Curatorship)
Graduate Diploma in Arts (Art History)
Graduate Diploma in Arts (Art History and Curatorship)

The graduate programs in Art History and Curatorship provide students with the opportunity to study the Australian visual arts, Aboriginal and Torres Strait Islander art, Asian art, the Classical Tradition, and Medieval art. Courses are also available in: Renaissance and Baroque traditions in Western European art and architecture; nineteenth century European art; Modernism and Postmodernism - both in theory and practice; Russian art; printmaking; photography; and curatorial studies.

ANU is uniquely situated amongst Canberra’s national cultural institutions, including: the National Gallery of Australia, National Museum of Australia, National Portrait Gallery, National Library, and the Australian War Memorial. Many of the University’s Art History and Curatorship graduates work in these institutions, and our nationally-renowned internship program enables students to undertake part of their studies within these institutions (see page 5 for more information about the internship).

Graduate Convenor
E arthistory.coursework@anu.edu.au

MASTER OF ARTS (ART HISTORY)
Graduate Diploma in Arts (Art History)
The Art History specialisation in the Master of Arts is designed for students who have completed a program of undergraduate studies, usually not in this discipline, who seek advanced qualifications for employment in the broad Art History sector.

Students enrolled in an Art History or Art History and Curatorship program also have the opportunity to learn on the job. The ANU has arrangements with a number of national institutions, as well as smaller galleries and museums, for students to undertake internships as part of their study program.

Typical courses
> Art and Architecture of Asia: Continuity and Change
> Art and its Context: Materials, Techniques, Display
> Art History Internship
> Art History Seminar Methodology
> Art History Sub-Thesis (MA Program)
> Art of the Modern Print
> Australian Art: 20th and 21st Century
> Curatorship Theory and Practice
> Fabric of Life: An Introduction to Textile History
> Modernism and Postmodernism in Art and Design: 1850-2000
> Painters of Modern Life
> Post-Colonial Discourses in Australian Art
> Russian Art: Icons and Revolutions
> The Art and Politics of Collecting
> Victorian and Edwardian Art: Australia and Europe 1837-1914
ENTRY
Graduate Diploma in Arts (Art History)
Applicants should have a three year Bachelors degree in a cognate area from an Australian tertiary institution or its international equivalent.

Master of Arts (Art History)
Applicants should have a four year Bachelors degree with Honours in a cognate area from an Australian tertiary institution or its international equivalent. Equivalence may be met by the completion of the Graduate Diploma in Arts (Art History) with a minimum 70% course average.

ATTENDANCE
On campus

DURATION
Graduate Diploma in Arts (Art History)
1 year full-time (course to the value of 36 units)

Master of Arts (Art History)
2 years full-time (courses to the value of 72 units)

STRUCTURE
Part A: Courses to the value of 36 units
Part B: Thesis of 25,000 - 30,000 words (36 units)

The Graduate Diploma is equivalent to Part A.

FULL PROGRAM INFORMATION
http://info.anu.edu.au/studyat/

FURTHER INFORMATION
arthistory.coursework@anu.edu.au

MASTER OF ARTS (ART HISTORY & CURATORSHIP)

Graduate Diploma in Arts (Art History & Curatorship)
The Art History and Curatorship graduate programs are designed to train students in Art History, engage in advanced level research, and to introduce museum curatorship practices. The programs are recognised as vocational training and for further study. The programs have a strong emphasis on critical analysis, research, problem solving, and communicating with audiences in diverse ways. It also provides valuable training for future managers in the art heritage and collections sectors, and broadly across the public service and private enterprise.

From 2011, the Master of Art History and Curatorship is available as a complete online program for domestic students unable to attend to the ANU campus program. The online program replicates the on campus program with its specific art historical knowledge and skills in visual analysis and critical analysis, research and written and oral communication skills.

Typical courses
> Curatorship Theory and Practice
> The Art and Politics of Collecting
> Art and its Context
> Art and its Context: Materials, Techniques, Display
> Curatorship Theory and Practice Photography: A History in Art
> Art of the Modern Print
> Fabric of Life: An Introduction to Textile History
> The Art and Politics of Collecting

ENTRY
Graduate Diploma in Arts (Art History & Curatorship)
Applicants should have a three year Bachelors degree in a cognate area from an Australian tertiary institution or its international equivalent.

Master of Arts (Art History & Curatorship)
Applicants should have a four year Bachelors degree with Honours in a cognate area from an Australian tertiary institution or its international equivalent. Equivalence may be met by the completion of the Graduate Diploma in Arts (Art History & Curatorship) with a minimum 70% course average.

ATTENDANCE
On campus and online

DURATION
Graduate Diploma in Arts (Art History & Curatorship)
1 year full-time (courses to the value of 36 units)

Master of Arts (Art History & Curatorship)
2 years full-time (courses to the value of 72 units)

STRUCTURE
Part A: Courses to the value of 36 units
Part B: Thesis of 25,000 - 30,000 words (36 units)

The Graduate Diploma is equivalent to Part A.

FULL PROGRAM INFORMATION
http://info.anu.edu.au/studyat/

FURTHER INFORMATION
arthistory.coursework@anu.edu.au

BIOGRAPHICAL RESEARCH & WRITING

Programs offered
Doctor of Philosophy (PhD)
Master of Philosophy (MPhil)
Master of Biographical Research and Writing

Biography allows us to explore some of the most fascinating questions of human existence. How do we come to be who we are? What is the essence of a life and character, and can we as biographers really know that essence? How are narratives of lives shaped by differences of culture, class or gender? Biographical work helps us to understand our history in new ways, and can cast fresh light on whole realms...
of political and social change. Biographical approaches are
growing ever more popular in a wide range of fields, from
history to heritage, politics to art.

The Master of Biographical Research and Writing is an
initiative of the National Centre of Biography at the ANU. The
Centre includes the Australian Dictionary of Biography and
other biographical projects, and acts as a focus for the study
of Biography in Australia.

Graduate Convenor
E  historyarts.graduate@anu.edu.au
W  http://ncb.anu.edu.au

MASTER OF BIOGRAPHICAL RESEARCH
& WRITING

The Master of Biographical Research and Writing provides
training in Biographical approaches and methodologies.
It equips students with a thorough theoretical and critical
grounding in Biography, and with the skills and opportunity
to undertake their own biographical projects.

The program is relevant for graduates wishing to undertake a
specialist postgraduate program in Biography. It is suitable for
professionals working in a variety of cultural institutions who
are finding Biography to be of increasing relevance to their
professional practice, independent scholars wishing to pursue
Biographical projects, intending PhD students interested in
undertaking postgraduate research in Biography, or anyone
wishing to broaden their knowledge and understanding of
past lives.

Graduates of the Master of Biographical Research and Writing
may go on to careers in writing and publishing Biography,
cultural and visual arts, the editorial and publishing worlds, the
public history and heritage sector, film, radio and television,
education, or the library and archives sector.

Typical courses
> Writing Biography
> Reading and Writing History
> History and Theory
> Oral History, Memory and Life Stories
> Biography and Society
> Digital Histories and Biographies
> Biographical Practices
> Australian Dictionary of Biography Internship
> Biographical Research Project

ENTRY
Applicants should have a four year Bachelors degree either
as Honours or a combined degree in a cognate area from
an Australian tertiary institution or its international equivalent.
Equivalence can be met with completion of either the
Graduate Certificate in Liberal Arts (Writing, World Histories
and Lives) (see page 37) or the Graduate Diploma in Arts
(History) (see page 32).

ATTENDANCE
Online courses and intensive courses on campus

DURATION
1 year full-time (courses to the value of 48 units)

FULL PROGRAM INFORMATION
http://info.anu.edu.au/studyat/

FURTHER INFORMATION
historyarts.graduate@anu.edu.au

BIOLOGICAL ANTHROPOLOGY

Programs offered
Doctor of Philosophy (PhD)
Master of Philosophy (MPhil)
Master of Biological Anthropology (Research)
Master of Biological Anthropology
Graduate Certificate in Biological Anthropology

Biological Anthropology is the branch of Anthropology that
focuses on the evolutionary and biological aspects of human
populations. Humans are varied and dynamically changing
sets of biological individuals – adaptable, but also vulnerable,
to ever-changing circumstances. The Biological Anthropology
courses encompass physical anthropology, primatology,
palaeoanthropology, and human biology, including human
genetics and the study of human adaptation, health, nutrition
and demography. Topics for graduate student research
cover a wide range, with the main supervision strengths
lying in primatology, human evolution, animal domestication,
bioarchaeology and palaeopathology, and indigenous health
and demography.

MASTER OF BIOLOGICAL ANTHROPOLOGY

Master of Biological Anthropology (Research)
Graduate Certificate in Biological Anthropology

Graduate studies in Biological Anthropology provide
students with a grounding in the main sub-fields of
Biological Anthropology. These include: primate evolution,
ecology, behaviour and conservation, human evolution,
animal domestication, palaeopathology, and bioarchaeology.
Study is also available in: ancient health and medicine;
forensic anthropology and archaeology; human population
genetic variation and anthropological genetics; human
population adaptation, health, nutrition, and ecology;
and anthropological demography.
**Typical courses**

- Analysis of Mammalian Remains
- Analytical Methods for Anthropology and Archaeology
- Ancient Health and Disease
- Ancient Medicine
- Anthropology of Emotion
- Archaeology of Death and Mortuary Practices
- Culture, Biology and Population Dynamics
- Forensic Anthropology and Archaeology
- Genes, Memes and Cultural Difference
- Human Evolution
- Human Skeletal Analysis
- Human Society as Animal Society: Sex, Conflict, Co-operation and Human Uniqueness
- Medical Anthropology
- Nutrition, Disease and the Human Environment
- Primate Ecology and Behaviour
- Primate Evolutionary Biology
- Race and Human Genetic Variation
- Research Design and Analysis in Biological Anthropology
- Scientific Dating and Isotope analysis for Archaeology and Paleoanthropology

**ENTRY**

**Graduate Certificate in Biological Anthropology**

Applicants should have a three year Bachelors degree from an Australian tertiary institution or its international equivalent. Applicants without a first degree, but with relevant professional experience and appropriate prior learning, will be eligible for admission into the Graduate Certificate in Biological Anthropology.

**Master of Biological Anthropology**

Applicants should have a four year Bachelors degree either as Honours or a combined degree in a cognate area from an Australian tertiary institution or its international equivalent. Equivalence may be met by the completion of the Graduate Certificate in Biological Anthropology.

**Master of Biological Anthropology (Research)**

Applicants must have completed the Master of Biological Anthropology with a minimum 70% course average.

**ATTENDANCE**

On campus

**DURATION**

**Graduate Certificate in Biological Anthropology**

0.5 years full-time (courses to the value of 24 units)

**Master of Biological Anthropology**

1 year full-time (courses to the value of 48 units)

**Master of Biological Anthropology (Research)**

1.5 years full-time (courses to the value of 72 units)

**FULL PROGRAM INFORMATION**

http://info.anu.edu.au/studyat/

**FURTHER INFORMATION**

For further information on the graduate research programs in Biological Anthropology contact:

E archpal@anu.edu.au
W http://archanth.anu.edu.au/bioanthropology

For further information on the graduate coursework programs in Biological Anthropology contact:

E admin.arch&anth@anu.edu.au
W http://archanth.anu.edu.au/graduate-programs

**CLASSICS**

**Programs offered**

Doctor of Philosophy (PhD)
Master of Philosophy (MPhil)
Master of Arts (Classics)
Graduate Diploma in Arts (Classics)

The graduate program in Classics and Ancient History offer students the opportunity to explore the languages, literature and mythology of the ancient Greek and Roman worlds as well as their history, culture and social life. It provides perspectives not only on the ancient world but, importantly, on the modern world too.

The ANU’s teaching and research strengths are both in language and literature and in ancient history. In literature we have special strengths in ancient Greek and Roman epic but are interested in all other genres. Our ancient historians encompass both Greek and Roman history from the early archaic period down to, and including, the Roman Empire.

The skills you acquire in analysing arguments, interpreting texts, writing clearly and convincingly are the skills that employers love. The study of cultures other than your own will open your mind. The study of Ancient Greek and Latin, as languages, makes you conscious of your use of your own language and your writing style. Classics graduates have gone on to become university teachers and administrators, professional research writers, senior public servants, museum curators, school teachers, journalists, librarians—the study of Classics and Ancient History will not limit you in your choice of career.

For further information on graduate programs in Classics contact:

Graduate Convenor
E classics@anu.edu.au
ALESHIA BAILEY

Master of Arts (Classics)

I’ve always had an interest in History and Languages. The ANU postgraduate Classics program gives me the opportunity to combine these interests.

I have really appreciated the insight I have gained into society today through an understanding of the past – particularly through learning about Ancient Rome and Greece. Through studying Latin I have also been able to develop my knowledge of the English language; in particular my vocabulary and understanding of grammar.

In my opinion a Master of Arts (Classics) from the ANU provides students with advanced communication, analytical and problem solving skills, which can create a solid foundation for numerous career opportunities.
MASTER OF ARTS (CLASSICS)

Graduate Diploma in Arts (Classics)

The Master of Arts specialising in Classics – by coursework and thesis - is designed for students who wish to undertake study in the language, history, literature, art, or other aspects of ancient Greek and Roman culture.

Typical courses

- Artefacts and Society in the Greco-Roman World
- Homer and the Trojan War
- The Hero in Classical Literature: Identity, Gender and Self-Definition in Ancient Poetry
- Traditional Grammar
- Ancient Greek
- The City in the Roman Empire
- Religion and Society in the Roman Empire
- Latin

ENTRY

Graduate Diploma in Arts (Classics)

Applicants should have a three year Bachelors degree in a cognate area from an Australian tertiary institution or its international equivalent.

Master of Arts (Classics)

Applicants should have a four year Bachelors degree with Honours in a cognate area from an Australian tertiary institution or its international equivalent. Equivalence may be met by the completion of the Graduate Diploma in Arts (Classics) with a minimum 70% course average.

ATTENDANCE

On campus

DURATION

Graduate Diploma in Arts (Classics)

1 year full-time (courses to the value of 36 units)

Master of Arts (Classics)

2 years full-time (courses to the value of 72 units)

STRUCTURE

Part A: Courses to the value of 36 units
Part B: Thesis of 25,000-30,000 words (equivalent to 36 units)

The Graduate Diploma is equivalent to Part A.

FULL PROGRAM INFORMATION

http://info.anu.edu.au/studyat/

FURTHER INFORMATION

classics@anu.edu.au
DEMOGRAPHY & SOCIAL RESEARCH

Programs offered
Doctor of Philosophy (PhD)
Master of Philosophy (MPhil)
Master of Social Research
Graduate Certificate in Social Research

The Australian Demographic and Social Research Institute (ADSRI) at the ANU is one of the world’s leading centres of training in Demography and Social Research. ADSRI also collaborates closely with a number of government agencies in Canberra.

Demography is a broad social science discipline concerned with the study of human populations. Demographers deal with the collection, presentation, and analysis of information relating to the basic life-cycle events and experiences of people. This discipline emphasises the theoretical and empirical investigation of population processes, and the study of their determinants and consequences. Practitioners frequently draw on related disciplinary areas: sociology; economics; political science; anthropology; psychology; public health and ecology; to illuminate their analyses. Students may also explore biological and biosocial aspects of fertility and mortality in areas such as reproductive health and epidemiology. The field of Demography is also concerned with the broader nature of social and economic change, and with the impact of demographic change on the natural environment.

For further information on graduate programs in Demography and Social Research contact:
Graduate Convenor
demography.gradprog@anu.edu.au
W http://adsri.anu.edu.au

MASTER OF SOCIAL RESEARCH

Graduate Certificate in Social Research

There is a growing demand in Australia and internationally for people with expertise in high-level social research methods. The Master of Social Research is a professional degree designed to provide training in social science research methods. Graduates of this program will have practical skills in social science research that can be applied in government, NGOs, and private organisations. Graduates will have a sound basis for conducting, commissioning, and evaluating research in the social sciences.

This degree includes four specialisations: Demography, Social Research Methods, Social Development, and Policy and Social Science of the Internet.

Typical courses
> Advanced Longitudinal Analysis
> Case Studies in Social Policy
> Demographic Forecasting and Projections
> Education and Labour Force
> Gender and Population
> Health Demography
> International Migration
> Introduction to Longitudinal Methods
> Online Research Methods
> Population and Australia
> Population and Society: Theory and Empirical Perspectives
> Population Policy and Planning
> Principles of Population Analysis
> Qualitative Research Analysis
> Social Research Design
> Social Research Practice
> Social Science of the Internet
> Special Topic in Social Research
> Statistics for Social Scientists
> Survey Data Analysis

ENTRY

Graduate Certificate in Social Research
Applicants should have a three year Bachelors degree from an Australian tertiary institution or its international equivalent. Applicants without a first degree, but with relevant professional experience and appropriate prior learning, will be eligible for admission into the Graduate Certificate in Social Research.

Master of Social Research
Applicants should have a four year Bachelors degree either as Honours or a combined degree in a cognate area from an Australian tertiary institution or its international equivalent. Equivalence may be met by the completion of the Graduate Certificate in Social Research.

ATTENDANCE
On campus

DURATION

Graduate Certificate in Social Research
0.5 years full-time (courses to the value of 24 units)

Master of Social Research
1 year full-time (courses to the value of 48 units)

FULL PROGRAM INFORMATION
http://info.anu.edu.au/studyat/

FURTHER INFORMATION
demography.gradprog@anu.edu.au
HEATHER CRAWFORD

Master of Social Research

I chose to study at the ANU because of its excellent reputation. The ANU also offers students flexible learning options, and I appreciate being able to balance part-time study with my family and work commitments.

After working in social statistics for over twenty years I was excited to discover the Master of Social Research – it fits with both my work experience and has allowed me to explore my interests in families, child well-being and social support.

I have found it inspiring to study at the ANU and to learn from academics who are undertaking innovative research in their field. In my experience, the lecturers have shared their knowledge generously, and have been consistently supportive of the students in my program, which has made for a very enjoyable and rewarding experience.

One of the best parts of studying at ANU has been the opportunity to learn from the experiences and varying perspectives of other students in my courses – many of whom have worked and studied elsewhere in Australia and overseas. I have also been fortunate in having the opportunity to work as a researcher at the ANU Australian Demographic and Social Research Institute.
DRAMA

Programs offered

Doctor of Philosophy (PhD)
Master of Philosophy (MPhil)

The Drama program at the ANU is focused on the practical aspects of theatre, film and TV. It encourages students to pursue research that actively increases our knowledge of the way a performance is persuaded to move - from the page or the imagination to the stage. Studies in acting and directing traditions and techniques are encouraged, as well as all aspects of theatre history and practice. It is also possible to pursue research in set and costume design.

For further information on graduate programs in Drama contact:
Graduate Convenor
E schoolofculturalinquiry@anu.edu.au

ENGLISH

Programs offered

Doctor of Philosophy (PhD)
Master of Philosophy (MPhil)

The English program is the centre of literary studies at the ANU. It offers supervision in Australian and British literature; the latter covering a range of historical periods from the Renaissance to today. The English program also focuses on: American, Commonwealth, and Comparative literature; Gender Studies; and Literary and Cultural Theory. The University's main research strengths for English are in: Renaissance literature; philosophy, literature and ethics; British eighteenth-century studies and Romanticism, including Jonathan Swift, theatre and Jane Austen; and post-colonial literatures, particularly Asian-Australian literature and theatre. Studies also focus on Twentieth Century Australian literature and American literature, particularly representations of Indigenous peoples. Graduate courses are also available for students in creative writing.

For further information on graduate programs in English contact:
Graduate Convenor
E schoolofculturalinquiry@anu.edu.au

FILM STUDIES

Programs offered

Doctor of Philosophy (PhD)
Master of Philosophy (MPhil)

The Film Studies program at ANU offers graduate degrees by research. It is also possible to combine a practical component, such as scriptwriting, or filmmaking, with a short thesis.

The Film Studies program focuses on documentaries, new media, European Cinema (especially French, German and Italian, with native speaker competence available in each), film and sound, film and performance, and general coverage of the aesthetics, theory and cultural history of film.

Film Studies students can access considerable resources in the University's video collection, as well as in the Chifley Library. There are also specialised holdings at the Australian War Memorial and the National Film and Sound Archive. Furthermore, Canberra has some of the world's leading documentary film-makers and lively film groups on and off campus.

For further information on graduate programs in Film Studies contact:
Graduate Convenor
E schoolofculturalinquiry@anu.edu.au

FORENSIC ANTHROPOLOGY

Programs offered

Doctor of Philosophy (PhD)
Master of Philosophy (MPhil)

Master of Archaeological Science – for advanced coursework options in Forensic Anthropology

Forensic Anthropology is rapidly developing a high profile both internationally and domestically. Much of this interest has been catalysed by way of media coverage of investigations into crimes against humanity and unsolved murders. Australians have been involved in this kind of work recently in, for example, East Timor and the Solomon Islands.

Forensic Anthropology, as a discipline, is primarily concerned with developing and applying a range of anthropological and archaeological skills to questions of medico-legal importance. Traditionally the discipline is broken down into three main sub-fields: (1) forensic osteology; (2) forensic archaeology; and (3) forensic taphonomy. Forensic osteology uses methods and procedures developed in physical anthropology and focuses on human identification by way of the analysis of physical remains (skeletal and dental material in general).
Forensic archaeology is concerned with managing and often excavating crime scenes that contain human remains (including mass graves in war-crimes situations). Forensic taphonomy is the examination and analysis of the various biological (e.g. decomposition), environmental (climate, soil acidity, temperature etc.), and cultural (e.g. evidence for trauma) changes that can impact on human remains both at the time of death and after death.

Students in the Master of Archaeological Science can choose from a range of courses in Forensic Anthropology.

**Typical courses**

- Forensic Anthropology and Archaeology
- Ancient Health and Disease
- Human Skeletal Analysis
- Archaeological Field and Laboratory Methods
- Research Design and Analysis in Archaeology

For further information on graduate research programs in Forensic Anthropology contact:
E archpal@anu.edu.au

For further information on graduate coursework programs in Forensic Anthropology please refer to the Master of Archaeological Science on page 19.

---

**Programs offered**

**Doctor of Philosophy (PhD)**

**Master of Philosophy (MPhil)**

Studies in Gender, Sexuality and Culture offers students the opportunity to undertake interdisciplinary and innovative graduate research.

The ANU has strengths in feminist theory, anthropology and history; literary, critical and cultural studies; gender and development; and international studies. More specific areas of expertise include: trauma studies; feminist and cultural studies of medicine, health and embodiment; South East Asian cinema and popular culture; and Asian modernities; law, literature and popular culture. Students may also study: feminist international relations; nationalism, maternity and sexuality; gender, migration and globalisation; and gender, cinema and visual culture.

For further information on graduate programs in Gender, Sexuality and Culture contact:
Graduate Convenor
E gradconvener.gender@anu.edu.au

---

**Higher Education**

**Programs offered**

**Doctor of Philosophy (PhD)**

**Master of Philosophy (MPhil)**

**Master of Higher Education**

**Graduate Certificate in Higher Education**

The Centre for Educational Development and Academic Methods (CEDAM) at the ANU offers two Higher Education coursework programs – a Master degree and Graduate Certificate in Higher Education. These programs are designed to complement the work of those involved in teaching, supervising research students, leading and managing others, or enabling others to learn and develop. The Centre also provides research programs for students interested in the Higher Degree by Research programs.

The Centre offers programs in the area of Higher Education including: doctoral education, research supervision, aspects of assessment, evaluation, and postdoctoral training. Programs are also available in Academic and Professional Practice, including academic work, teaching, learning and curriculum in higher education, continuing professional learning, and the teaching-research nexus.

For further information on graduate programs in Higher Education contact:
Graduate Convenor
E cedam@anu.edu.au
W http://cedam.anu.edu.au/

**MAStEr oF HIGHER EDUCATION**

**Graduate Certificate in Higher Education**

The graduate programs in Higher Education provide an opportunity for academics and others to contextualise and enhance the effectiveness of their academic practice. The program focuses on undergraduate teaching, postgraduate research supervision, and academic leadership and management.

It supports participants in the design and pursuit of professional development plans through information, structured reflections, and conducting projects related to their own practice and current needs.

**Typical courses**

- Academic Leadership and Management
- Action Learning Project
- Enhancing your Academic Practice
- Learning and Teaching in Higher Education
- Research Supervision
- Curriculum Design and Innovation
ENTRY
Graduate Certificate in Higher Education
Applicants should have a three year Bachelors degree from an Australian tertiary institution or its international equivalent. Applicants without a first degree, but with relevant professional experience and appropriate prior learning, will be eligible for admission into the Graduate Certificate in Higher Education.

Master of Higher Education
Applicants should have a four year Bachelors degree either as Honours or a combined degree in a cognate area from an Australian tertiary institution or its international equivalent. Equivalence may be met by the completion of the Graduate Certificate in Higher Education.

Please note that due to the part-time delivery of the program, this program is not available to international students.

ATTENDANCE
On campus

DURATION
Graduate Certificate in Higher Education
1 year part-time (courses to the value of 24 units)

Master of Higher Education
2 years part-time (courses to the value of 48 units)

FULL PROGRAM INFORMATION
http://info.anu.edu.au/studyat/

FURTHER INFORMATION
http://cedam.anu.edu.au/

HISTORY
Programs offered
Doctor of Philosophy (PhD)
Master of Philosophy (MPhil)
Master of Arts (History)
Graduate Diploma in Arts (History)

The History program at the ANU offers teaching and supervision in the histories of Australia, the United States, Europe, and the British Empire. The programs cover the ancient, early modern, and modern periods. These regions and periods are approached from a wide range of historical perspectives including: social, cultural, political, technological, medical, legal, intellectual, transnational, gender, sexuality, and the body.

Coursework and research are also offered in Biographical Research and Writing (see page 22).

For further information on graduate programs in History contact:

Graduate Convenor
E historyarts.graduate@anu.edu.au
W http://history.cass.anu.edu.au/

MASTER OF ARTS (HISTORY)
Graduate Diploma in Arts (History)
The graduate Arts programs specialising in History allow students to deepen their understanding of the Modern and Ancient periods and a variety of international and social contexts.

Typical courses
> American Sixties
> American Voices: Aspects of Social Thought in the United States, 1900-1990
> Australians at Work
> Convicts and Emigrants: Australia, 1770s to 1870s
> Country Lives: Australian Rural History
> Crimes, Courts and Crucifixions: Maintaining Order in the Roman Empire
> Healing Powers: Medicine and Society Since 1750
> History and Theory
> History of Western Sexuality
> Human Variations and Racism in Western Culture, c. 1450-1950
> Indigenous Australian History
> Museums and Society
> Popular Culture, Gender and Modernity
> Real Men: Manhood and Identity in the Western World
> Religion and Society in the Roman Empire
> Researching and Writing History
> Technology and Society, 1800-2000
> The French Revolution and Napoleonic Europe
> The Great War, 1914-1918
> Tudor-Stuart England c.1485-1714: Politics, Society, Culture
> Urban Australia, 1870-1970
> World At War, 1939-1945

ENTRY
Graduate Diploma in Arts (History)
Applicants should have a three year Bachelors degree in a cognate area from an Australian tertiary institution or its international equivalent.

Master of Arts (History)
Applicants should have a four year Bachelors degree with Honours in a cognate area from an Australian tertiary institution or its international equivalent. Equivalence may be met by the completion of the Graduate Diploma in Arts (History) with a minimum 70% course average.

ATTENDANCE
On campus
DURATION
Graduate Diploma in Arts (History)
1 year full-time (courses to the value of 36 units)
Master of Arts (History)
2 years full-time (courses to the value of 72 units)

STRUCTURE
Part A: Courses to the value of 36 units
Part B: Thesis of 25,000 - 30,000 words (36 units)
The Graduate Diploma is equivalent to Part A.

FULL PROGRAM INFORMATION
http://info.anu.edu.au/studyat/

FURTHER INFORMATION
historyarts.graduate@anu.edu.au

INDIGENOUS AUSTRALIAN STUDIES

Programs offered
Doctor of Philosophy (PhD)
Master of Philosophy (MPhil)
Master of Arts (Indigenous Australian Studies)
Graduate Diploma in Arts (Indigenous Australian Studies)

Indigenous Australian Studies is an interdisciplinary program in which students may combine courses in Anthropology, Archaeology, English, Gender and Sexuality, History, Linguistics, Music, and the Visual Arts. These studies provide students with a broad understanding of Indigenous Australian societies and cultures - both in the past and the present. Students may then build on this understanding to explore an area in-depth through the writing of a thesis.

Research in Indigenous Australian Studies at the ANU covers many key areas including: Aboriginal languages, with application to Indigenous language education; and mapping social, religious and territorial organisation, which provides a basis for Indigenous governance, land claims and native title issues. Students may also conduct archaeological and historical research that helps to inform cultural heritage management and produce local histories and biographies; document and analyse art and performance to increase public understanding of Indigenous cultural production and its social and economic dimensions; and document economic circumstances to help produce better development outcomes.

For further information on graduate programs in Indigenous Australian Studies contact:
Graduate Convenor
E admin.arch&anth@anu.edu.au
W http://info.anu.edu.au/studyat/

MASTER OF ARTS
(INDIGENOUS AUSTRALIAN STUDIES)

Graduate Diploma in Arts
(Indigenous Australian Studies)

The graduate courses at the ANU provide a comprehensive insight into Indigenous Australian Studies. This includes: the origins of Indigenous Australian people; their occupation and adaptation to the continent; their traditional social, cultural, linguistic, musical and artistic practices; the impact of European colonisation; the place of Indigenous Australian people in Australian society today; and the representation of Indigeneity in literature and biography.

Typical courses
> Indigenous Australian Societies and Culture
> Indigenous Australians and Australian Society Today
> Graduate Reading Course (Anthropology)
> Introduction to Australian Indigenous Policy
> Australian Archaeology
> Aboriginal and Torres Strait Islander Art
> Trauma, Memory and Culture
> Indigenous Australian History
> Language in Indigenous Australian Society

ENTRY
Graduate Diploma in Arts
(Indigenous Australian Studies)
Applicants should have a three year Bachelors degree in a cognate area from an Australian tertiary institution or its international equivalent.

Master of Arts (Indigenous Australian Studies)
Applicants should have a four year Bachelors degree with Honours in a cognate area from an Australian tertiary institution or its international equivalent. Equivalence may be met by the completion of the Graduate Diploma in Arts (Indigenous Australian Studies) with a minimum 70% course average.

ATTENDANCE
On campus

DURATION
Graduate Diploma in Arts (Indigenous Australian Studies)
1 year full-time (courses to the value of 36 units)
Master of Arts (Indigenous Australian Studies)
2 years full-time (courses to the value of 72 units)

STRUCTURE
Part A: Courses to the value of 36 units
Part B: Thesis of 25,000 - 30,000 words (36 units)
The Graduate Diploma is equivalent to Part A.

FULL PROGRAM INFORMATION
http://info.anu.edu.au/studyat/

FURTHER INFORMATION
admin.arch&anth@anu.edu.au
INTERDISCIPLINARY AND CROSS-CULTURAL STUDIES

Programs offered

Doctor of Philosophy (PhD)
Master of Philosophy (MPhil)

Graduate Research in Interdisciplinary and Cross-Cultural Studies is designed to develop new modes of research as well as to use traditional scholarly methods to provide innovative insights into the different ways that cross-cultural relations and histories are constructed and represented.

Led by internationally renowned scholars from the Centre for Cross-Cultural Research and the Humanities Research Centre and other departments within the University, the research programs offer students expert supervision within and across a range of disciplinary boundaries, including anthropology, visual anthropology, history, art history, literature and the visual arts, and seeks to encourage students to adopt an interdisciplinary and comparative perspective in their research.

In addition, expert advisers are available from a range of national cultural institutions located in Canberra, including the National Museum of Australia, the National Library of Australia, the National Portrait Gallery, and the Australian Institute of Aboriginal and Torres Strait Islander Studies.

Students will be able to take advantage of intellectual and multimedia collaborations already instituted by the Centres and will have opportunities to be involved in the production of exhibitions, colloquia and multi-media projects, as well as to undertake short, practical internships. The program provides unique opportunities for research training in the context of collaborative team research, in partnership with cultural institutions and industries.

For further information on graduate programs in Interdisciplinary and Cross-Cultural Studies contact:

E intercultural.gradprog@anu.edu.au
W http://info.anu.edu.au/studyat/Graduate_School/Study_Fields/intercultural

LANGUAGES

Programs offered

Doctor of Philosophy (PhD)
Master of Philosophy (MPhil)

The graduate research programs in Languages offer research supervision in a wide variety of areas. This includes: Ancient Greek and Latin literature; literary theory; literature in modern European languages; nomadic and migrant literature, and literature across cultures and art forms. Students may also research language, culture and identity in politics; translation theory and practice; language teaching policy, and history. Research is available in teaching and learning European languages as a second language - including curriculum design, teaching of culture, literature, pragmatics, discourse, and writing. Other areas of interest at the ANU are: linguistics, second language acquisition theory; French in the Pacific; gender studies in Italy, phraseology and culture; and sociolinguistics of Italian and Spanish. Finally, students may also research teaching and learning to write in a foreign language, curriculum design in German tertiary programs, second language acquisition of Indonesian in instructed settings, and monolingual and bilingual first language acquisition of Mandarin.

Postgraduate Language courses are offered for Graduate Studies Select students, including:

> Ancient Greek
> Arabic
> French
> German
> Italian
> Latin
> Persian
> Spanish
> Turkish

Students interested in Languages should also see Applied Linguistics (page 38).

For further information on graduate programs in Languages contact:

Graduate Convenor
E language.studies@anu.edu.au
W http://languages.anu.edu.au/

LIBERAL ARTS

Programs offered

Master of Liberal Arts (Cultural and Environmental Heritage) - Research
Master of Liberal Arts (Museums and Collections) - Research
Master of Liberal Arts (Visual Culture Research) - Research
Master of Liberal Arts (Writing, World Histories and Lives) - Research
Master of Liberal Arts (Cultural and Environmental Heritage)
Master of Liberal Arts (Museums and Collections)
Master of Liberal Arts (Visual Culture Research)
Master of Liberal Arts (Writing, World Histories and Lives)
Graduate Certificate in Liberal Arts (Cultural and Environmental Heritage)
Graduate Certificate in Liberal Arts (Museums and Collections)
Graduate Certificate in Liberal Arts (Visual Culture Research)
Graduate Certificate in Liberal Arts (Writing, World Histories and Lives)
Graduate Certificate in Museum Education and Heritage Interpretation
For further information on graduate programs in Liberal Arts contact:
Graduate Convenor
E  administration.rsha@anu.edu.au
W  http://rsha.anu.edu.au/liberal-arts

MASTER OF LIBERAL ARTS (CULTURAL & ENVIRONMENTAL HERITAGE)

Master of Liberal Arts (Cultural & Environmental Heritage) – Research

Graduate Certificate in Liberal Arts (Cultural & Environmental Heritage)

The Cultural and Environmental Heritage program aims to provide students with the depth of knowledge necessary to engage in cultural and environmental heritage-related employment and to undertake high-level research within this broad discipline. We offer a range of topics that provide a background to heritage theory and practice, as well as specialist topics that draw upon the expertise of ANU staff and international leaders in different areas of heritage. We provide a global outlook on heritage practice and our program reflects contemporary demands for a more comprehensive approach to heritage concepts. Individualised internship programs, strong industry connections and expertise in practice-led research combine to provide students with a strong sense of intellectual context as well as professional training. Courses are taught flexibly and we offer a range of learning approaches and intensive (short) courses.

Typical courses
- Cultural and Environmental Heritage: Key Concepts and Practices
- Physical Conservation of Historic Heritage Places
- World Heritage
- Best Practice in Managing Heritage Places
- Connections to Country: Understanding Indigenous Heritage in Australia
- Rock Art Field School
- Cultural Landscapes
- Cultural and Environmental Heritage Research Project
- World Rock Art
- Managing Small Museums and Heritage Places
- Material Culture Studies
- Internship Programs
- 6 and 12 unit research topics

ENTRY
Graduate Certificate in Liberal Arts (Cultural & Environmental Heritage)
Applicants should have a three year Bachelors degree from an Australian tertiary institution or its international equivalent. Applicants without a first degree, but with relevant professional experience and appropriate prior learning, will be eligible for admission into the Graduate Certificate in Liberal Arts (Cultural & Environmental Heritage).

Master of Liberal Arts
(Cultural & Environmental Heritage)
Applicants should have a four year Bachelors degree either as Honours or a combined degree in a cognate area from an Australian tertiary institution or its international equivalent. Equivalence may be met by the completion of the Graduate Certificate in Liberal Arts (Cultural & Environmental Heritage).

Master of Liberal Arts
(Cultural & Environmental Heritage) – Research
Applicants must have completed the Master of Liberal Arts (Culture & Environmental Heritage) with a minimum 70% course average.

ATTENDANCE
On campus or online

DURATION
Graduate Certificate in Liberal Arts
(Cultural & Environmental Heritage) 0.5 years full-time (courses to the value of 24 units)

Master of Liberal Arts
(Cultural & Environmental Heritage) 1 year full-time (courses to the value of 48 units)

Master of Liberal Arts
(Cultural & Environmental Heritage) - Research 1.5 years full-time (courses to the value of 72 units)

FULL PROGRAM INFORMATION
http://info.anu.edu.au/studyat/

FURTHER INFORMATION
liberalarts.rsha@anu.edu.au

MASTER OF LIBERAL ARTS (MUSEUMS & COLLECTIONS)

Master of Liberal Arts
(Museums & Collections) – Research

Graduate Certificate in Liberal Arts
(Museums & Collections)

The Museums and Collections specialisation gives students a working knowledge of, and critical engagement with, a wide range of museums, cultural, and collecting institutions. Most coursework content draws from case studies provided by national cultural and collecting institutions in Canberra. The ANU has formed partnerships with numerous museums and collections in Canberra including the National Museum of Australia, Australian War Memorial, National Portrait Gallery of Australia, and the National Library of Australia.
These links mean that students have ready access to major national collections and exhibition venues. Furthermore, the program can complement academic excellence with a strong professional emphasis, to ensure that students remain at the forefront of current research and issues confronting museums, galleries, and other cultural and collecting institutions.

Typical courses
> Museums and Collections: Key Concepts and Practices
> Exhibition Innovations Workshop
> Indigenous Collections and Exhibitions
> Internship 1 and 2
> Managing Small Museums and Heritage Places
> Museum Management
> 6 and 12 unit research topics
> Museums, Art and Society in the Asia-Pacific
> Practical Skills in Exhibition Design and Delivery

ENTRY
Graduate Certificate in Liberal Arts (Museums & Collections)
Applicants should have a three year Bachelors degree from an Australian tertiary institution or its international equivalent. Applicants without a first degree, but with relevant professional experience and appropriate prior learning, will be eligible for admission into the Graduate Certificate in Liberal Arts (Museums and Collections).

Master of Liberal Arts (Museums & Collections)
Applicants should have a four year Bachelors degree either as Honours or a combined degree in a cognate area from an Australian tertiary institution or its international equivalent. Equivalence may be met by the completion of the Graduate Certificate in Liberal Arts (Museums and Collections).

Master of Liberal Arts (Museums & Collections) – Research
Applicants must have completed the Master of Liberal Arts (Museums & Collections) with a minimum 70% course average.

ATTENDANCE
On campus

DURATION
Graduate Certificate in Liberal Arts (Museums and Collections)
0.5 years full-time (courses to the value of 24 units)

Master of Liberal Arts (Museums and Collections)
1 year full-time (courses to the value of 48 units)

Master of Liberal Arts (Museums and Collections) - Research
1.5 years full-time (courses to the value of 72 units)

FULL PROGRAM INFORMATION
http://info.anu.edu.au/studyat/

FURTHER INFORMATION
liberalarts.rsha@anu.edu.au

MASTER OF LIBERAL ARTS (VISUAL CULTURE RESEARCH)

Master of Liberal Arts (Visual Culture Research) - Research

Graduate Certificate in Liberal Arts (Visual Culture Research)
The Visual Culture Research specialisation of the Liberal Arts program is a multi-disciplinary field. It combines the humanities and social scientific perspectives of Anthropology, Art Theory, and Film Studies with workshops using visual media and relevant software. It also develops students' skills in working with visual materials. Graduates achieve a high level of visual literacy – an ability to analytically grasp visual materials from a range of disciplinary perspectives, and an understanding of the key conceptual debates in visual studies. Students also develop a practical familiarity with a range of visual media and the relevant software for working with visual materials. Through ‘hands on’ exercises, students combine these analytical and practical skills, developing the ability and confidence to manipulate visual materials for research-related purposes.

Typical courses
> Anthropology of Media
> Arguing Objects
> Digital Media Methods
> Documentary: Real Life in Virtual Space
> Filming Cultures
> Framing the World: Mediating Relations
> Interdisciplinary Humanities Research: Methods, Theories and Skills
> Internship 1 and 2
> Master classes in Ethnographic Film
> Photography in Social Context
> Points Of View
> Thinking with a Video Camera (Intensive)
> Visual Culture Research: Extended Project
> Visual Culture Research: Key Concepts
> Visual Culture Research: Special Topics
> Visual Cultures of Asia
> Visual Research Project

ENTRY
Graduate Certificate in Liberal Arts (Visual Culture Research)
Applicants should have a three year Bachelors degree from an Australian tertiary institution or its international equivalent. Applicants without a first degree, but with relevant professional experience and appropriate prior learning, will be eligible for admission into the Graduate Certificate in Liberal Arts (Visual Culture Research).

Master of Liberal Arts (Visual Culture Research)
Applicants should have a four year Bachelors degree either as Honours or a combined degree in a cognate area from an Australian tertiary institution or its international equivalent.
Equivalence may be met by the completion of the Graduate Certificate in Liberal Arts (Visual Culture Research).

**Master of Liberal Arts (Visual Culture Research) – Research**
Applicants must have completed the Master of Liberal Arts (Visual Culture Research) with a minimum 70% course average.

**ATTENDANCE**
On campus and online

**DURATION**
Graduate Certificate in Liberal Arts (Visual Culture Research)
0.5 years full-time (courses to the value of 24 units)

Master of Liberal Arts (Visual Culture Research)
1 year full-time (courses to the value of 48 units)

Master of Liberal Arts (Visual Culture Research) - Research
1.5 years full-time (courses to the value of 72 units)

**FULL PROGRAM INFORMATION**
http://info.anu.edu.au/studyat/

**FURTHER INFORMATION**
liberalarts.rsha@anu.edu.au

**MASTER OF LIBERAL ARTS (WRITING, WORLD HISTORIES & LIVES)**

**Master of Liberal Arts (Writing, World Histories & Lives) – Research**

Graduate Certificate in Liberal Arts (Writing, World Histories & Lives)
The Writing, World Histories and Lives specialisation will equip students with a deep understanding of the dynamic impact of economic and social processes of globalisation on contemporary culture, the study of history, and literary studies. The courses in this stream offer comparative, transnational, and postcolonial approaches for analysing an increasingly interconnected world. Writing, World Histories and Lives students also have the opportunity to complete an internship and gain on-the-job training that provides credit towards their degree.

Graduates trained in this program will be well equipped to work in a range of professional environments that increasingly demand finer understanding of difference and diversity on the one hand, and common goals of global citizenship and human co-existence on the other. Examples include cultural institutions, academia, the public service, international institutions such as the UN, and NGOs.

**Typical courses**
- Biography and Society
- Freilich Foundation Summer School: Topics in Bigotry and Tolerance
- Interdisciplinary Humanities Research: Methods, Theories and Skills

**ENTRY**
Graduate Certificate in Liberal Arts (Writing, World Histories and Lives)
Applicants should have a three year Bachelors degree from an Australian tertiary institution or its international equivalent. Applicants without a first degree, but with relevant professional experience and appropriate prior learning, will be eligible for admission into the Graduate Certificate in Liberal Arts (Writing, World Histories and Lives).

Master of Liberal Arts (Writing, World Histories and Lives)
Applicants should have a four year Bachelors degree either as Honours or a combined degree in a cognate area from an Australian tertiary institution or its international equivalent. Equivalence may be met by the completion of the Graduate Certificate in Liberal Arts (Writing, World Histories and Lives).

Master of Liberal Arts (Writing, World Histories and Lives) – Research
Applicants must have completed the Master of Liberal Arts (Writing, World Histories and Lives) with a minimum 70% course average.

**ATTENDANCE**
On campus

**DURATION**
Graduate Certificate In Liberal Arts (Writing, World Histories and Lives)
0.5 years full-time (courses to the value of 24 units)

Master Of Liberal Arts (Writing, World Histories and Lives)
1 year full-time (courses to the value of 48 units)

Master Of Liberal Arts (Writing, World Histories and Lives) - Research
1.5 years full-time (courses to the value of 72 units)

**FULL PROGRAM INFORMATION**
http://info.anu.edu.au/studyat/

**FURTHER INFORMATION**
liberalarts.rsha@anu.edu.au
GRADUATE CERTIFICATE IN MUSEUM EDUCATION & HERITAGE INTERPRETATION

The Graduate Certificate in Liberal Arts (Museum Education and Heritage Interpretation) is designed to meet Australia's growing need for qualified professional educators and interpreters in the field of curatorial studies, museums, heritage sites, and art galleries. The program provides in-service professional development for museum professionals wanting to formalise or extend their capabilities in the field of museum learning. It is also designed for primary and secondary teachers wanting to engage further with museums as a study site, or those looking for a career change opportunity.

This program prepares students for professional roles within museum and heritage education, including for schools or the public. The courses give students both the theoretical knowledge and practical skills to develop and implement learning programs for museums/heritage audiences of all ages and backgrounds. It also provides effective background preparation for those wishing to study a higher degree by research in the field of museum education and heritage interpretation.

ENTRY
Applicants should have a three year Bachelors degree from an Australian tertiary institution or its international equivalent. Applicants without a first degree, but with relevant professional experience and appropriate prior learning, will be eligible for admission into the Graduate Certificate in Museum Education and Heritage Interpretation.

ATTENDANCE
On campus

DURATION
0.5 years full-time (courses to the value of 24 units)

FULL PROGRAM INFORMATION
http://info.anu.edu.au/studyat/

FURTHER INFORMATION
museumandeducation.convenor@anu.edu.au

LINGUISTICS & APPLIED LINGUISTICS

Programs Offered
Doctor of Philosophy (PhD)
Master of Philosophy (MPhil)
Master of Applied Linguistics (Research)
Master of Linguistics (Research)
Master of Applied Linguistics
Master of Linguistics
Master of Translation
Graduate Certificate in Linguistics

Graduate Studies in Linguistics at ANU draws upon the expertise of the largest concentration of linguists in the southern hemisphere. For more than 20 years, research in Linguistics at the ANU has focused on the descriptive and comparative study of the languages of Australia, Papua-New Guinea, the Pacific Islands, Indonesia and China.

Linguistics
Linguistics involves studying the nature of human language, from a scientific point of view. It seeks to understand the nature of language as a universal human faculty and means of communication. Graduate courses in Linguistics are designed to cater for the needs of students who are specialising in the study of a particular language or language family; want to help extend the frontiers of what is known about the nature of human language; or have an interest in meaning, communication and cognitive studies.

Applied Linguistics
ANU has a strong and vibrant Applied Linguistics program. Whereas many other Applied Linguistics programs focus primarily on the teaching and learning of languages, specifically through their TESOL offerings, the ANU does not limit itself to Applied Linguistics in this traditional sense.

This program is in close contact with the Linguistics program, the Translation program, the European languages programs (French, Spanish, German, Italian), and Applied Linguistics within the College of Asia & the Pacific (Japanese, Korean, Chinese, Indonesian). This means that students studying Applied Linguistics at the ANU can draw on the expertise of a variety of researchers who are working within very different, yet related, fields.

For further information on graduate programs in Linguistics and Applied Linguistics contact:
Graduate Research Convenor
E linguistics.gradprog@anu.edu.au

Graduate Postgraduate Convenor - Linguistics
E linguistics.gradcwk@anu.edu.au

Graduate Postgraduate Convenor – Applied Linguistics
E appliedlinguistics.gradcwk@anu.edu.au
W http://linguistics.anu.edu.au/

Students interested in Linguistics and Applied Linguistics should also see Languages (page 34).

MASTER OF LINGUISTICS

Master of Linguistics (Research)
Graduate Certificate in Linguistics

This program focuses on the nature and structure of language. It is designed for students interested in the description and explanation of particular languages, or of human linguistic capabilities in general.
XUJIA DU

Master of Applied Linguistics

I chose to study at the ANU for a number of reasons. The ANU Master of Applied Linguistics allowed me to explore my interest in Socio-Linguistics, and has provided a pathway for me into research, as well as career opportunities, in the field of Linguistics.

The best part of my program is the opportunity to both study coursework and conduct research and write a thesis. I found the researchers and supervising staff at the ANU to offer the support and research expertise that I need to pursue research in my areas of interest.
Typical courses

- Child Language Acquisition
- Chinese Linguistics
- Conversation Analysis
- Cross Cultural Communication
- Dictionaries and Dictionary-Making
- Field Methods
- Graduate Reading Course (Linguistics)
- Introduction to Syntax
- Introduction to the Study of Language
- Language, Culture and Translation
- Language and Society
- Language Change
- Language in Indigenous Australian Society
- Language Planning and Language Politics
- Language Power and Identity
- Languages in Contact
- Morphology
- Phonetics: Sounds of the World’s Languages
- Phonological Analysis
- Readings in Applied Linguistics
- Research Design in (Applied) Linguistics
- Second Language Acquisition
- Semantics
- Seminar on Semantics
- Special Topics in Linguistics
- Study of a Language Family
- Syntactic Theory
- The History of the English Language
- The Structure of English

ENTRY

Graduate Certificate in Linguistics
Applicants should have a three year Bachelors degree from an Australian tertiary institution or its international equivalent. Applicants without a first degree, but with relevant professional experience and appropriate prior learning, will be eligible for admission into the Graduate Certificate in Linguistics.

Master of Linguistics
Applicants should have a four year Bachelor degree either as Honours or a combined degree in a cognate area from an Australian tertiary institution or its international equivalent. Equivalence may be met by the completion of the Graduate Certificate in Linguistics.

Master of Linguistics (Research)
Applicants must have completed the Master of Linguistics with a minimum 70% course average.

ATTENDANCE

On campus

DURATION

Graduate Certificate in Linguistics
0.5 years full-time (courses to the value of 24 units)

Master of Linguistics
1 year full-time (courses to the value of 48 units)

Master of Linguistics (Research)
1.5 years full-time (courses to the value of 72 units)

FULL PROGRAM INFORMATION

http://info.anu.edu.au/studyat/

FURTHER INFORMATION

linguistics.gradcwk@anu.edu.au

MASTER OF APPLIED LINGUISTICS

Master of Applied Linguistics (Research)
Graduate studies of Applied Linguistics provide students with the opportunity to study the nature of language. It focuses on applications such as first and second language acquisition; second language teaching and literacy, language and classroom education across the curriculum, language policy and planning. Studies of Applied Linguistics also includes: the use of language in university academic contexts; intercultural communication; language and the law; forensic speaker identification; speech pathology; translation; and advertising. In other words, it uses knowledge of how languages work within different applied settings. Students can select subjects to specialise in Applied Japanese Linguistics.

This program would particularly benefit students who are interested in working as a foreign language teacher, translator, editor, speech pathologist, audiologist or in language policy areas.

Typical courses

- Child Language Acquisition
- Conversation Analysis
- Cross Cultural Communication
- Dictionaries and Dictionary-Making
- Graduate Reading Course (Linguistics)
- Language and Culture
- Language and Society
- Language in Indigenous Australian Society
- Language Policy and Language Politics
- Language Power and Identity
- Readings in Applied Linguistics
- Research Design in (Applied) Linguistics
- Second Language Acquisition
- Teaching Languages
- Translation across Languages: Specialised Materials
- Translation across Languages: The Translation of Literary Texts
- TESOL (offered through other universities)
ENTRY

Master of Applied Linguistics
Applicants should have a four year Bachelors degree either as Honours or a combined degree in a cognate area ie Linguistics or Applied Linguistics from an Australian tertiary institution or its international equivalent. Equivalence may be met by the completion of the Graduate Certificate in Linguistics.

Master of Applied Linguistics (Research)
Applicants must have completed the Master of Applied Linguistics with a minimum 70% course average.

International Students
International students interested in the Languages, Linguistics and Applied Linguistics programs are encouraged to read the ANU Information for International Students (http://info.anu.edu.au/studyat/International_Office) for more information.

ATTENDANCE
On campus

DURATION
Master of Applied Linguistics
1 year full-time (courses to the value of 48 units)

Master of Applied Linguistics (Research)
1.5 years full-time (courses to the value of 72 units)

FULL PROGRAM INFORMATION
http://info.anu.edu.au/studyat/

FURTHER INFORMATION
appliedlinguistics.gradcwk@anu.edu.au

MASTER OF TRANSLATION
The Master of Translation is jointly offered by the ANU College of Asia and the Pacific and the ANU College of Arts and Social Sciences. The program is designed to provide students with a focused qualification in the practice of literary translation. It gives students an understanding of the history of translation, and an appreciation of a number of critical issues in the field. This program is particularly useful for those working in the field of translation.

Master of Translation students specialise in translating between English and any of the languages taught at ANU. These language specialisations include: Arabic, Burmese, Chinese, Classical Latin and Greek, French, German, Hindi, Italian, Indonesian, Japanese, Javanese, Korean, Pacific Pidgins, Persian, Russian, Sanskrit, Spanish, Tetum, Thai, Turkish, Urdu, and Vietnamese.

Typical courses

> Translation Across Languages: The Translation of Literary Texts
> Translation Across Languages: Specialised Material
> Language and Culture
> Critical Readings for Translators
> Advanced Spanish

> Japanese-English Translation
> Italian Studies: Advanced Italian
> Readings in Southeast Asian Culture
> Translation from Indonesian
> Advanced German
> Advanced French
> Case Studies in Translation (Chinese/English)
> Toolkit for Chinese Studies and Translation
> Translating Chinese Literature

ENTRY
Applicants should have obtained an Australian Bachelors degree with Honours (four years) or an overseas equivalent; a three year Bachelor (pass) degree with either a relevant Graduate Certificate or Diploma ie Graduate Certificate in Linguistics or a three year Bachelor degree and relevant work experience. All applicants must meet the University’s minimum English language requirements and have advanced competency in a second language.

ATTENDANCE
On campus

DURATION
1 year full-time (courses to the value of 48 units)

FULL PROGRAM INFORMATION
http://info.anu.edu.au/studyat

FURTHER INFORMATION
language.studies@anu.edu.au
studentadmin.cap@anu.edu.au
MUSIC

Programs offered
Doctor of Philosophy (PhD)
Master of Philosophy (MPhil)
Master of Music
Graduate Diploma in Music
Graduate Certificate in Music Performance

Graduate programs in Music provide students with the opportunity to undertake research and further study in their selected field of Music. The programs are designed for students who wish to further develop their creative, performing, technical, or academic expertise by pursuing a particular area of Music. This may include: the study of a particular repertoire; performing practices; the creation of a body of original work; the production of a folio of sound recordings; the application of pedagogical methods; musicological study involving original research; or reinterpretation of existing bodies of knowledge.

Research and coursework programs are available in the following areas: Performance, Jazz Performance, Composition, Jazz Arranging and Composition, Musicology, Pedagogy, and Accompaniment.

For further information on graduate programs in Music contact:
Graduate Convenor
E music.gradprog@anu.edu.au

MASTER OF MUSIC

Each area within the School of Music has designed a Master program of study. This means there are different forms of presentation and written and oral assessment requirements between taught coursework and projects across the Master programs.

Areas of study
Performance (Including Jazz)
Performance Studies is available for a range of instruments taught through the School of Music (including Jazz), and involves participating in both solo and ensemble performances. Solo recitals may include accompaniment and chamber music.

Musicology
Musicology is designed for those students wishing to undertake a range of specialised musicological studies, leading towards further research in Music. It is also suitable for those wishing to transfer or combine their skills and knowledge from another field of Music, or another discipline, into musicology; or for students who wish to incorporate a range of interdisciplinary coursework into their Music study. In particular, through individual study, it provides the opportunity for students to participate in a supervised professional placement in one of the national collecting institutions, and to complete a project on an aspect of the collections. Students may also choose to study the management of a range of performance activities.

Composition
Composition studies seeks to further develop students’ skills, knowledge, creativity and experience across the stylistic, technical and expressive dimensions of Composition in a contemporary context. During their program, Composition students are expected to undertake an in-depth study of a variety of musical works, of diverse musical styles and techniques, and that offer different creative approaches or artistic concepts. Students should also take the opportunities to participate in or observe rehearsals and performances by staff and students of the School. In addition, where possible, students should develop opportunities for performances of their works at the School and elsewhere by collaborating with performers.

ENTRY
Applicants should have a four year Bachelors degree in music with relevant experience, or an Honours degree and demonstration of an advanced level of skill and knowledge in a selected field - typically through an audition. Graduates of four year programs in fields other than Music, who show a high level capacity or aptitude in a nominated field of Music, may also receive entry to this program.

Students are normally required to audition, or submit a folio of their work, and be interviewed at the School of Music. Some programs may require students to complete additional tests. For overseas and interstate applicants, an audio/video recording and/or folio of work may be considered as a provisional audition.

ATTENDANCE
On campus

DURATION
1 year full-time (courses to the value of 48 units)

FULL PROGRAM INFORMATION
http://info.anu.edu.au/studyat/

FURTHER INFORMATION
music.gradprog@anu.edu.au

GRADUATE DIPLOMA IN MUSIC

This program is designed for students wishing to pursue advanced musical studies. It allows students to develop skills and knowledge in a particular area of Music study, and may allow students to qualify for admission to a higher degree. The Graduate Diploma in Music is available in a number of specialisations.

Performance Only

The Performance Only specialisation is available for performers who have already reached an advanced level of technical and musical skill. Graduate courses in Performance are offered in: Strings, Woodwind, Brass, Percussion, Keyboard, Guitar, Harp, and Voice. Students specialise in solo performance, but may include chamber music or vocal ensemble as part of their studies.
Performance and Research Project

The Performance and Research Project specialisation is available for students who have already reached an advanced level of technical and musical skill, and who are interested in undertaking research in a particular area of music. Students undertake a research project that complements their Performance studies.

Jazz Performance

Students who specialise in Jazz Performance may study either solo performance or jazz ensemble. Tuition is available for the following instruments: Bass, Drums, Clarinet, Flute, Guitar, Piano, Saxophone, Trombone, Violin, Trumpet, and Voice. Throughout their study students are expected to participate in concerts and give recitals.

Jazz Arranging and Composition

The Jazz Arranging and Composition specialisation provides students with the opportunity to develop skills in composing and arranging jazz music, both for small and large ensembles. Students also complete courses in the analysis of music composition.

Pedagogy (Aural/Music Theory)

The Pedagogy specialisation is primarily designed for practising teachers who wish to upgrade their skills in music Pedagogy. The focus is on approaches to teaching music literacy and aural/theory development.

Accompaniment

The Accompaniment specialisation is a structured program of practical study in accompaniment in instrumental and vocal studies. The program includes: piano and accompaniment tuition; studio experience in instrumental departments; studio experience in the voice department, including works in European languages; chamber music; and early keyboard techniques. Graduates of this program may be able to follow careers as professional accompanists or as members of chamber ensembles.

Musicology

The Musicology specialisation aims to teach students the skills and approaches necessary to conduct professional music research. It develops students' knowledge across a range of historical, musicological or ethnomusicological topics, and allows students to develop deepened knowledge in a Musicology research topic of their choice.

ENTRY

Applicants should have a three year bachelors degree from an Australian tertiary institution or its international equivalent.

Students are normally expected to audition and attend an interview at the School of Music. Some programs may require students to complete additional tests. Overseas and interstate applicants may send high quality audio/video recordings and/or a folio.
PHILOSOPHY

Programs offered
Doctor of Philosophy (PhD)
Master of Philosophy (MPhil)

Graduate studies in Philosophy at the ANU are strong in analytical, continental, and applied philosophy. Few universities in Australia can offer this sort of scope for students to follow their individual interests. Students can undertake a variety of topics including: ethics; philosophy of probability and decision theory; philosophy of biology; political philosophy; probability; metaphysics and epistemology; French and German; Eighteenth Century English philosophy; and the philosophies of art, mind and language.

For further information on graduate programs in Philosophy contact:
Graduate Convenor
E philosophy.gradprog@anu.edu.au
W http://philosophy.cass.anu.edu.au

POLITICAL SCIENCE & INTERNATIONAL RELATIONS

Programs offered
Doctor of Philosophy (PhD)
Master of Philosophy (MPhil)

Graduate studies in research for Political Science and International Relations at ANU covers a wide range of contemporary domestic and international political issues.

Political science
Political Science research at the ANU includes: political parties and institutions; interest groups and electoral systems; public policy; health and welfare policy; political theory; and political economy.

International relations
Research in International Relations includes the international political economy; globalization; international relations theory; European politics; political literature and international relations; gendered international politics; diplomacy, strategy and foreign policy; international terrorism; security studies; and development studies.

Social and Political Theory
Social and Political Theory is a growing area of interest in Australia and internationally. It involves a number of disciplines including Philosophy, Political Science, Sociology, Economics, and Law.

For further information on graduate programs in Political Science and International Relations contact:
Graduate Convenor
E polsci.gradprog@anu.edu.au
W http://politicsir.cass.anu.edu.au/future-students/graduate
Sociology

Programs offered
Doctor of Philosophy (PhD)
Master of Philosophy (MPhil)

Graduate studies in Sociology focus on social processes and structures in Australia and other industrialised countries, and on the processes of development in non-Western societies. It aims to develop both theoretical and empirical research skills and encourages both quantitative and qualitative approaches.

The Sociology program includes studies in: equality of opportunity and relative equity; social mobility; social and health policy; gender, ethnic and life cycle inequalities; sociology of health and medicine; and social networks. Research is also conducted in political and social attitudes; globalisation and international immigration; immigrants in the labour market; ethnic and racial relations; social structure; and sociological theory.

For further information on graduate programs in Sociology contact:
Graduate Convenor
E sociology.gradprog@anu.edu.au
W http://sociology.cass.anu.edu.au/future-students/graduate-hdr

Visual, Digital & Design Arts

Programs offered
Doctor of Philosophy (PhD)
Master of Philosophy (MPhil)
Master of Digital Arts (Research)
Master of Visual Arts (Research)
Master of Design Arts
Master of Digital Arts
Master of Visual Arts
Graduate Diploma in Digital Arts
Graduate Diploma in Visual Arts
Graduate Certificate in Digital Arts
Graduate Certificate in Visual Arts

Graduate students in the School of Art are primarily involved in practice led research; that is, research based on a process of development and testing of knowledge through the creation of works of art. Students develop experimental and analytical methodologies and locate their work within specific historical, cultural, and theoretical contexts. The programs are designed for students who wish to extend their creative, technical and analytical skills under the supervision of expert staff.

In the Research programs, students construct a practice-based project under the supervision of a panel whose expertise encompasses theory and practice. The PhD and MPhil programs include a creative arts coursework component.

The Graduate Certificate, Diploma and Masters level coursework programs incorporate individual studio practice projects, core theory, masterclasses, field studies, research projects and other courses from allied areas. This broad choice enables different patterns of study at postgraduate coursework level to suit a student’s individual needs and interests.

Areas taught in the School include: Ceramics, Digital Media, Glass, Gold and Silversmithing, Furniture, Painting, Photomedia, Printmaking and Drawing, Sculpture and Textiles.

Design Arts

The Design Arts program provides students with the opportunity to develop their professional skills as designer/makers by studying in a chosen workshop area, including Ceramics, Furniture, Glass, Gold and Silversmithing, Sculpture, and Textiles.

Digital Arts

The graduate Digital Arts programs are aimed at students who wish to study creative Digital Arts in the areas of video, animation, compositing, Internet art, processing, sound, and hybrid practice.

Visual Arts

The Visual Arts programs provide students with the opportunity to develop their skills as professional artists and professionals in the arts sector. Study is available in a variety of Workshops including: Art Theory, Ceramics, Furniture, Glass, Gold and Silversmithing, Printmedia and Drawing, Painting, Photography and Media Arts, Sculpture, and Textiles.

Graduate Convenor
E enquiries.visualarts@anu.edu.au
W http://soa.anu.edu.au/

Master of Design Arts

In the Design Arts graduate program, students develop a self-initiated design project in areas such as Ceramics, Furniture, Glass, Gold and Silversmithing, Sculpture, and Textiles. Projects might include the development of object/product lines for studio prototyping or production and may form the basis for industrial production with particular emphasis on technical, aesthetic and production outcomes.

Typical courses
> Design Arts Studio Practice courses

Entry

A four year Bachelors degree either as Honours or a combined degree in a cognate area from an Australian tertiary institution or its international equivalent, or a three year Bachelors degree in a cognate area with a minimum of two years relevant professional practice/experience. Equivalence may be met by the completion of the Graduate Certificate in Visual Arts or the Graduate Diploma in Visual Arts.
Applicants must submit a curriculum vitae and a portfolio to substantiate their skills and experience. The curriculum vitae should include: academic qualifications, short courses attended, exhibition history, publications, arts-related employment, prizes, membership of arts-related organisations, committee membership, and any other relevant information. The portfolio may include: digital images, a website, prototypes, video, or other forms. Images should include a range of recent design works relevant to the disciplinary area to which entry is sought.

Students must nominate a workshop from the listed areas on application.

**ATTENDANCE**
On campus

**DURATION**
Two semesters plus one summer session full-time (courses to the value of 48 units)

**FULL PROGRAM INFORMATION**
http://info.anu.edu.au/studyat/

**FURTHER INFORMATION**
enquiries.visualarts@anu.edu.au

**MASTER OF DIGITAL ARTS**

**Master of Digital Arts (Research)**

**Graduate Diploma in Digital Arts**

**Graduate Certificate in Digital Arts**

The graduate programs in Digital Arts offer students the opportunity to undertake practical study in key areas of digital media such as digital video, 3D computer animation, digital compositing, interactivity, coding, the Internet, sound, and hybrid media. A Visual Effects specialization is possible at Graduate Diploma and Masters level. Students deepen and extend their creativity using skills in use throughout the film and media industries and the creative arts sector. Programs involve students in a mix of theory and elective courses.

**Typical courses**

- New Media, Innovation and Research
- Animation
- Internet Art
- Physical Computing for the Creative Arts
- Video Art
- Digital Compositing
- Photography
- Studio Practice
- Visual Arts Studio Master-class
- Formal Structures for New Media
- Computer Music: Theory and Aesthetics
- Interactive Digital Media
- Compositing for Digital Visual Effects
- Digital Video
- Animation Elements for Digital Visual Effects

**ENTRY**

**Graduate Certificate in Digital Arts**
Appropriate level skills as demonstrated through portfolio and CV and a three year Bachelors degree from an Australian tertiary institution or its international equivalent or a cognate VET Diploma with a minimum of two years professional practice or relevant professional practice with a minimum of 4 years experience.

**Graduate Diploma in Digital Arts**
Appropriate level skills as demonstrated through portfolio and CV and a three year Bachelors degree in a cognate area from an Australian tertiary institution or its international equivalent. Equivalence may be met by the completion of the Graduate Certificate in Digital Arts.

**Master of Digital Arts**
Appropriate level skills as demonstrated through portfolio and CV and a four year Bachelors degree either as Honours or a combined degree in a cognate area from an Australian tertiary institution or its international equivalent or a three year Bachelors degree in a cognate area with a minimum of two years relevant professional practice/experience. Equivalence may be met by the completion of the Graduate Certificate in Digital Arts or the Graduate Diploma in Digital Arts.

**Master of Digital Arts (Research)**
Applicants must have completed the Master of Digital Arts with a minimum 70% course average. External applicants must substantiate appropriate level skills as demonstrated through portfolio and CV.

**ADDITIONAL ENTRY REQUIREMENTS**

All applicants must submit a curriculum vitae and a portfolio to substantiate their skills and professional experience. Applicants are encouraged to visit the School of Art website for more information on portfolio expectations.

**ATTENDANCE**
On campus

**DURATION**

**Graduate Certificate in Digital Arts**
0.5 years full-time (courses to the value of 24 units)

**Graduate Diploma in Digital Arts**
1 year full-time (courses to the value of 48 units)*

**Master of Digital Arts**
1 year full-time (courses to the value of 48 units)*

**Master of Digital Arts (Research)**
1.5 years full-time (courses to the value of 72 units)

* student portfolio and CV submission will be assessed for entry into the Graduate Diploma or Masters program.

**FULL PROGRAM INFORMATION**
http://info.anu.edu.au/studyat/

**FURTHER INFORMATION**
enquiries.visualarts@anu.edu.au
MASTER OF VISUAL ARTS

Master of Visual Arts (Research)

Graduate Diploma in Visual Arts

Graduate Certificate in Visual Arts

The University’s graduate programs in Visual Arts provide students with a range of courses, including studio practice, research, theory, masterclasses, fieldwork and other courses across the School of Art and allied areas. Students develop advanced skills and extend their understanding of creative practice. The program prepares students for careers as practising artists, teachers, administrators, or for work in museums, galleries, the public sector, private enterprise.

Typical courses
> Points of View
> Issues in Contemporary Craft
> Arguing Objects
> Research
> Visual Arts Master-class
> Studio Practice

ENTRY

Graduate Certificate in Visual Arts
Appropriate level skills as demonstrated through portfolio and CV and a three year Bachelors degree from an Australian tertiary institution or its international equivalent or a cognate VET Diploma with a minimum of two years professional practice or relevant professional practice with a minimum of 4 years experience.

Graduate Diploma in Visual Arts
Appropriate level skills as demonstrated through portfolio and CV and a three year Bachelors degree in a cognate area from an Australian tertiary institution or its international equivalent. Equivalence may be met by the completion of the Graduate Certificate in Visual Arts.

Master of Visual Arts
Appropriate level skills as demonstrated through portfolio and CV and a four year Bachelors degree either as Honours or a combined degree in a cognate area from an Australian tertiary institution or its international equivalent or a three year Bachelors degree in a cognate area with a minimum of two years relevant professional practice/experience. Equivalence may be met by the completion of the Graduate Certificate in Visual Arts or the Graduate Diploma in Visual Arts.

Master of Visual Arts (Research)
Applicants must have completed the Master of Visual Arts with a minimum 70% course average. External applicants must substantiate appropriate level skills as demonstrated through portfolio and CV.

ADDITIONAL ENTRY REQUIREMENTS
Students must nominate a primary Workshop. Entry to other workshop areas is negotiated with Workshop Heads prior to enrolment in specific courses.

Applicants must submit a curriculum vitae and a portfolio to substantiate skills and experience. The curriculum vitae should include: academic qualifications, short courses attended, exhibition history, publications, arts-related employment, prizes, membership of arts-related organisations, committee membership, and any other relevant information. The portfolio may include: digital images, a website, video, or other forms. Images should include a range of recent artworks relevant to the disciplinary area to which entry is sought.

ATTENDANCE
On campus (off campus study is available for some courses with approval)

DURATION
Graduate Certificate in Visual Arts
0.5 years full-time (courses to the value of 24 units)

Graduate Diploma in Visual Arts
1 year full-time (courses to the value of 48 units)*

Master of Visual Arts
1 year full-time (courses to the value of 48 units)*

Master of Visual Arts (Research)
1.5 years full-time (courses to the value of 72 units)

* student portfolio and CV submission will be assessed for entry into the Graduate Diploma or Masters program.

FULL PROGRAM INFORMATION
http://info.anu.edu.au/studyat/

FURTHER INFORMATION
enquiries.visualarts@anu.edu.au
WHO CAN I TALK TO?

GENERAL ENQUIRIES
T +61 2 6125 2898
E students.cass@anu.edu.au

EVENTS 2011

There are numerous activities organised both within Australia and overseas which allow students to speak to ANU representatives in person. Some of these include:

10 May – Graduate Information Evening
ANU campus

Throughout 2011 – ANU Advisory Days – Canberra, Sydney, Melbourne, Adelaide, Perth, Brisbane, and Hobart

July, Monday 25 – Thursday 28
ANU Visit to New Zealand

August, Saturday 27 – ANU Open Day

September – MBA and Postgraduate Expos – Sydney (6 September), Brisbane (8 September), Canberra (13 September), Melbourne (20 September), and Perth (22 September)

Full details on all of these events can be found at:
http://studyat.anu.edu.au/graduate_events.html
**POSTGRADUATE GLOSSARY**

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Academic Progress</strong></td>
<td>Students enrolled in undergraduate and graduate coursework awards at ANU are expected to maintain a satisfactory level of academic progress. Academic Progress Rules are set out on the website <a href="http://www.anu.edu.au/cabs/rules">www.anu.edu.au/cabs/rules</a>.</td>
</tr>
</tbody>
</table>
| **Census Date** | The Census Date for a course is the date by which a student must:  
> submit a completed Request for Commonwealth Support and HECS-HELP form or the Request for FEE-HELP Assistance form  
> finalise the arrangements for payment of their student contribution amount if a Commonwealth supported student.  
The following dates apply:  
> Semester 1 Census Date: 31 March  
> Semester 2 Census Date: 31 August  
For course Census Dates in non-standard Sessions see the Study@ANU website. |
<p>| <strong>Commonwealth Assistance Notice (CAN)</strong> | A Notice that contains information about a student's enrolment and use of Commonwealth assistance. This Notice will be provided to students electronically. |
| <strong>Commonwealth Higher Education Student Support Number (CHESSN)</strong> | A unique identifier for each student that will remain with a student throughout their university studies. It allows students to access Commonwealth assistance for higher education. |
| <strong>Commonwealth Supported Place (CSP)</strong> | A Commonwealth supported place is a higher education place for which the Government makes a financial contribution. It is one of the ways in which the Government contributes to the cost of students' education. Commonwealth supported places were previously referred to as Higher Education Contribution Scheme (HECS) places. |
| <strong>Conferring Ceremony</strong> | The public graduation ceremony at which awards of the University are presented to and conferred upon those persons who are deemed to have completed all the requirements for the respective award of the University. |
| <strong>Course</strong> | A discrete entity of study in a subject, normally of one semester or session in duration. A four character alphabetic subject area code and a four-digit numeric catalogue number identify each course. The first digit denotes the stage/year of the program in which the course is normally taken. Each course is normally assigned a unit value that is a measure of the proportion of the academic progress that a course represents within the total credit for the program. |
| <strong>Coursework</strong> | A group of courses constituting all or part of the requirements for an award (degree, diploma, certificate). |
| <strong>Deadlines (Fees)</strong> | The University has set final dates for payment of all fees (e.g. up front HECS-HELP, Tuition Fees, etc.). Students who fail to pay by the specified dates may have their enrolment cancelled. If permitted to reregister their enrolment by the Registrar they will be required to pay all outstanding fees plus a penalty fee as determined by the University. |
| <strong>Domestic Student</strong> | A student who is an Australian citizen, a New Zealand citizen or the holder of an Australian Permanent Resident visa. |
| <strong>Discipline</strong> | A field of related studies. |
| <strong>DTF</strong> | Domestic Tuition Fee. Fee payable by Australian citizens or permanent residents enrolled in a course on a fee-paying basis. |
| <strong>EFTSL</strong> | ‘Equivalent Full-Time Student Load’ is a measure of student load expressed as a proportion of the workload for a standard annual program, based on the accumulated course EFTSL for a program. For graduate research students, a weight of one if full-time; half if part-time; for undergraduates and non-research graduates determined on course enrolment. |
| <strong>Enrolment</strong> | A student's enrolment refers to the formal registration of program structure such as selected courses, program leave and a student to a program; (expressed as enrolment in a program, College or course). All new and continuing students must formally enrol by registering courses on ISIS. Enrolment instructions for new students are provided at the time of offer of admission. |
| <strong>Enrolment Variation</strong> | Within prescribed rules and deadlines, students may, having completed formal enrolment procedures, vary their enrolment by adding or dropping courses. |
| <strong>Exclusion</strong> | Refusal of re-enrolment due to an unsatisfactory rate of progress — see the Academic Progress Rules or Discipline Rules for more information. |
| <strong>FEE-HELP</strong> | A loan scheme to help eligible non-Commonwealth supported students pay their domestic tuition fees (DTF). Australian citizens and holders of a permanent humanitarian visa are eligible for FEE-HELP assistance. |</p>
<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FEE-HELP Balance</td>
<td>The amount of FEE-HELP that a student may access at a given point in time. The FEE-HELP balance is the FEE-HELP limit minus the amount of FEE-HELP that a student has used up to a certain point in time.</td>
</tr>
<tr>
<td>FEE-HELP Limit</td>
<td>The maximum amount of tuition fees that a student can receive a FEE-HELP loan for over their lifetime. The limit in 2009 is $104,142 for medicine, dentistry, veterinary science students and $83,313 for all other students. This limit is indexed each year. See the Fees website for more details.</td>
</tr>
<tr>
<td>Full-time Student</td>
<td>ANU students studying 18 or more units in a half year (January - June or July - December) are considered to be full-time students. International Students should note that they are normally required to be enrolled at 100% intensity which normally equates to 24 units in a half year.</td>
</tr>
<tr>
<td>Graduate Coursework</td>
<td>Undertaking a Graduate Certificate, Graduate Diploma or Masters by coursework program.</td>
</tr>
<tr>
<td>Graduate Research</td>
<td>Undertaking a Masters of Philosophy (MPhil) or Doctor of Philosophy (PhD) program.</td>
</tr>
<tr>
<td>HECS</td>
<td>Students who prior to 2005 did not pay tuition fees were required to contribute towards the cost of their education under the Commonwealth Government’s Higher Education Contribution Scheme (HECS). HECS liability was derived by calculating the proportion of a full-time load a student was undertaking and was assessed at the Census Date in each semester.</td>
</tr>
<tr>
<td>HECS-HELP</td>
<td>A scheme that includes upfront payment discounts and loans to help eligible Commonwealth supported students pay their student contribution amounts.</td>
</tr>
<tr>
<td>Higher Education Loan Program</td>
<td>A loan program to help eligible students pay student contribution amounts (HECS-HELP), tuition fees (FEE-HELP) and overseas study expenses (OS-HELP).</td>
</tr>
<tr>
<td>Higher Education Provider</td>
<td>Universities and higher education institutions listed in subdivision 16-B of HESA and providers as determined by the Minister under section 16-35 of HESA.</td>
</tr>
<tr>
<td>International Student</td>
<td>A student who is not an Australian or New Zealand citizen or the holder of permanent resident status. Required to hold a visa to study in Australia and is liable for international student fees (ISF) payable to the University either by the student or a sponsor.</td>
</tr>
<tr>
<td>ISF</td>
<td>International Student Fee (see also International Student).</td>
</tr>
<tr>
<td>ISIS</td>
<td>ISIS (Interactive Student Information Services) is a web-based system that allows students to access certain personal and academic information held on the University’s student system, including examination results, enrolment and graduation details.</td>
</tr>
<tr>
<td>Non-award Program/Courses</td>
<td>Courses not leading to an award; may be components of a pre-tertiary, undergraduate or graduate award program. Students in such programs have permission to undertake certain courses from an award program and receive normal instruction, assessment and examination results in the courses.</td>
</tr>
<tr>
<td>OS-HELP</td>
<td>A loan available to eligible undergraduate students who undertake some of their program overseas.</td>
</tr>
<tr>
<td>Part-time Student</td>
<td>ANU students studying 17 or fewer units in a half year (January - June or July - December) are considered to be part-time students. International Students should note that they are normally required to be enrolled at 100% intensity which normally equates to 24 units in a half year.</td>
</tr>
<tr>
<td>Prerequisite (Course)</td>
<td>Within programs in CASS, prerequisite refers to courses that must be completed satisfactorily before enrolment will be permitted in a specified course.</td>
</tr>
<tr>
<td>Program</td>
<td>A structured sequence of study, undertaken in one or more colleges of the University, normally leading to the award of a degree, diploma or certificate. The program is controlled by one or two (in the case of combined programs) specified authorities. A program is identified by a four-digit code, e.g. 3100 Bachelor.</td>
</tr>
<tr>
<td>Program Leave</td>
<td>An approved period of leave from a program may be granted to a student on application. Such leave is normally restricted to a maximum period of two semesters in the first instance. Students must apply using the online application form.</td>
</tr>
<tr>
<td>Request for Commonwealth Support and HECS-HELP form</td>
<td>The electronic form that an eligible student must complete in order to receive a Commonwealth supported place and HECS-HELP.</td>
</tr>
<tr>
<td>Request for Commonwealth Support form</td>
<td>The electronic form that pre-2005 HECS students must complete in order to receive a Commonwealth supported place, HECS-HELP and FEE-HELP.</td>
</tr>
<tr>
<td>SAS (DR &amp; SS)</td>
<td>Student Administration Services (SAS) is located in the Pauline Griffin Building (11) and Melville Hall (12). SAS contains areas such as Admissions, Enrolments, Fees, Examinations, Timetabling and Graduations. The SAS Enquiries Counter on the Ground Floor of the Pauline Griffin Building is a good first point of contact for any administration questions. The SAS Enquiries Counter is also where student cards, tuition fee payments and academic transcripts are processed.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Semester</td>
<td>In each academic year there are two semesters (Semester 1 and Semester 2), normally of 13 weeks duration divided into two teaching periods, with a non-teaching period of two weeks between each of the two teaching periods.</td>
</tr>
<tr>
<td>Semester Course</td>
<td>A course offered during first or second semester.</td>
</tr>
<tr>
<td>Session</td>
<td>The session is the academic period of study. For most students this will be Semester 1 and Semester 2. It could also be a non-standard session (Summer, Autumn, Winter or Spring Session).</td>
</tr>
<tr>
<td>Sponsor</td>
<td>An organisation such as an employer or government agency that officially registers with the ANU to pay the tuition fees directly to the University for one or more students.</td>
</tr>
<tr>
<td>Student Contribution Amount</td>
<td>The amount that a Commonwealth supported student pays for a course of study. The amount will vary depending on the discipline area (bands) to which the courses belong and when a student commenced.</td>
</tr>
<tr>
<td>Student Contribution Band</td>
<td>One of four bands of disciplinary areas into which a given course of study will fall. The student contribution amount/charge for each course will vary depending upon discipline area (band) to which a course belongs. See the Fees Section of this Guide for more detail on Student Contribution banding.</td>
</tr>
<tr>
<td>Student Learning Entitlement (SLE)</td>
<td>An entitlement that gives eligible students access to a Commonwealth supported place. There are three types of SLE - ordinary SLE, additional SLE and lifelong SLE. Normally students are entitled to up to 7 years full-time equivalent of SLE.</td>
</tr>
<tr>
<td>Student Load</td>
<td>The proportion of the standard full-time program taken by a student in a particular stage of a particular program calculated on the sum of the weight of all courses undertaken. (See also EFTSL.) The standard full-time annual student load for most programs is 48 units.</td>
</tr>
<tr>
<td>Testamur</td>
<td>The official document certifying that a student has been admitted to an award and had the award conferred in person or 'in absentia'. It may include details of award level (e.g. Honours) and specialisation.</td>
</tr>
<tr>
<td>Transcript of Academic Record</td>
<td>A Transcript of Academic Record is a certified statement detailing a student's complete academic record at the University. It includes details of all programs/courses in which the student has had an effective enrolment and the marks/grades achieved in courses. (Marks are only included for courses taken since 1994.) It also lists University prizes and graduation details where applicable. It is issued to students on request and the payment of a charge.</td>
</tr>
<tr>
<td>UAC</td>
<td>NSW and ACT University Admissions Centre.</td>
</tr>
<tr>
<td>Unit</td>
<td>This is an indicator of the value of the course within the total program. Most courses are valued at 6 units.</td>
</tr>
<tr>
<td>University ID (Student Number)</td>
<td>A seven-digit number which uniquely identifies a student or staff member at the University.</td>
</tr>
</tbody>
</table>
CONTACT

ANU College of Arts and Social Sciences
Beryl Rawson Building (Building 13)
The Australian National University
Canberra ACT 0200 Australia
T  +61 2 6125 2898
E  students.cass@anu.edu.au
W  http://cass.anu.edu.au
ANU online handbook: www.anu.edu.au/studyat

ANU CRICOS Provider Number 00120C